
 

  ABOUT CAPTURE

  Welcome to Capture, a RAD8, RAD7 and DRYSTIK communications tool for Windows and
macOS. Capture is used to download radon data files from the RAD8 and RAD7, display
sophisticated graphs of radon data, configure Durridge devices, and monitor their statuses in real
time.

Capture 8 is offered in two editions: Capture 8 Pro and Capture 8 Lite. The Lite edition is
provided free of charge, while Capture Pro offers a host of advanced features, and is
recommended for RAD8 users. For details, please see the Activating Capture Pro section.

Capture's radon graph window provides navigation controls, context-sensitive statistics panels,
and extensive data configuration options. Radon data may be exported to a variety of human-
readable formats, as well as printed in high resolution. Capture's Chart Recorder lets you monitor
the status of a RAD8 or RAD7 in real time. As the instrument performs a test, the radon data can
be logged to disk or to Capture Cloud in real time.

In addition to Capture's RAD8 and RAD7 related functionality, the program can also communicate
with the Durridge DRYSTIK ADS-3 active moisture exchanger, monitoring its status and configuring
the device for optimal performance.

First-time Capture users are encouraged to begin with the Obtaining RAD8 and RAD7 Data
section of this manual, which provides information on connecting to a RAD8 or RAD7, transferring
radon data to the computer, and displaying a radon data graph.

We appreciate your purchase of Durridge instruments, and we are pleased to offer Capture to help
you get the most out of your investment. More information on Durridge Products, including the
RAD8 and RAD7, is available at http://www.durridge.com.

Capture Updates Capture is undergoing continuous improvement with new features and refinements. Program
updates are deployed simultaneously for Windows and macOS. For a list of all the latest
improvements, see the Capture Version History page on the Durridge website.

Capture will alert you when a new version of the software is available for download, as shown
below. You can also make sure you are using the latest version of Capture by selecting the
Updates Panel in the Settings Window and clicking the Check Now button.

When a new version of Capture has finished downloading, the installer will launch (on Windows), or
the disk image will mount on the desktop (on macOS).

https://durridge.com/documentation/capture_help/vers_8.1.2/installingcapture.html#activatingcapturepro
https://durridge.com/documentation/capture_help/vers_8.1.2/capturecloud.html
https://durridge.com/documentation/capture_help/vers_8.1.2/obtainingrad8andrad7data.html
http://www.durridge.com/
http://www.durridge.com/software_capture_version_history.shtml
https://durridge.com/documentation/capture_help/vers_8.1.2/prefswindow.html#updatespanel
https://durridge.com/documentation/capture_help/vers_8.1.2/prefswindow.html


Figure 1: The Update Available notification.

Figure 2: Downloading a Capture update.



  INSTALLING CAPTURE

System Requirements Capture is available for Windows and macOS. The Windows version of Capture is compatible with
Windows 8.1 or newer, including Windows 10 and Windows 11. The macOS version of Capture
requires macOS 10.14 (Mojave) or newer.

Durridge offers older versions of Capture for versions of Windows dating back to Windows XP, and
for macOS systems dating back to Mac OS X 10.6. These versions of Capture may be
downloaded from the Legacy Versions of Capture page at the Durridge website.

To run Capture, a computer must have at least 4 GB of memory. A display resolution of 1280 by
800 pixels is required, but a full HD display (1920 by 1080 pixels) is recommended for viewing
radon data graphs in high detail. HiDPI/Retina displays are fully supported.

Capture can communicate with the RAD8 via the USB-A to USB-Mini B cable supplied with the
RAD8. It can communicate with a RAD7 using the serial to USB adaptor included with the RAD7.
In either case it may be necessary to install driver software. The appropriate driver installers are
available at the Software Drivers page on the Durridge website.

Windows Installation To install Capture on Windows, download the Capture application installer from the Durridge
website. Launch the installer and follow the on-screen instructions.

 

Figure 1: The Capture installer on Windows.

 

Figure 2: Installing Capture on Windows.



  The installer will place shortcuts to the application on the Windows desktop and in the Start Menu
if desired. The installer will offer to launch Capture 8 when the installation is complete.

Bypassing Microsoft Defender SmartScreen

Note that when launching the Capture installer or the Capture application for Windows for the first
time, you may see a warning from Microsoft stating that "Windows protected your PC. Microsoft
Defender SmartScreen prevented an unrecognized app from running". If this happens, click "More
info" as shown in Figure 3 below.

Figure 3: Microsoft Defender SmartScreen preventing the application from starting.

Next check the App and Publisher information as shown in Figure 4 below, and if it is correct click
Run anyway:

Figure 3: Microsoft Defender SmartScreen preventing the application from starting.

Microsoft Windows SmartScreen may flag newly released software as potentially hazardous, even
if the application contains a digital signature from a reputable developer. Be assured that Durridge
software has been code-signed by the manufacturer and will not put your PC at risk.



macOS Installation To install Capture on macOS, download the Capture disk image from the Durride website, and
mount it on your computer's desktop. Open the disk image, and drag the Capture application icon
onto the nearby alias of the Applications folder to copy it to your computer. Locate Capture in the
Applications folder and drag it to the Dock for easy access if desired. Unmount the Capture disk
image after the application has been copied to your computer.

It may be necessary to adjust the system's Security settings to allow Capture to launch. In the
System Settings, enter the Privacy & Security panel and make sure that the system is set to allow
applications from identified developers, rather than being restricted to applications downloaded
from the App Store. It may also be necessary to right-click on the Capture application and choose
Open from the pop-up menu that appears, to bypass security restrictions.

Figure 5: The Capture macOS disk image.

Activating Capture Pro Capture 8 is offered in two editions: Capture 8 Pro and Capture 8 Lite. The Lite edition is
provided free of charge, and it includes the features found in earlier Capture releases, in addition to
basic support for the RAD8. Capture Pro offers a host of advanced features, unlocking the full
potential of the RAD8. Capture Pro also provides access to Capture Cloud, Event-Driven Actions,
and other advanced program functionality.

To purchase a Capture Pro license, visit https://durridge.com/software/capture/.

After purchasing a Capture Pro license, you will receive a License Key from Durridge. To activate
Capture Pro, launch Capture 8 and choose Capture License... from the Help Menu (on Windows)
or the Application Menu (on macOS). Enter your name, email address, and License Key in the
Capture License Window as shown in Figure 6, below. A Capture Pro License Key consists of five
sets of four alphanumeric characters, separated by dashes.

If you would like to try Capture Pro before committing to the purchase of a license, choose "I want
to start a 30 Day Capture Pro Trial". After the trial period ends, Capture will revert to Capture Lite.

If you have purchased Capture Pro but you do not know your License Key, or if your License Key
has been lost, click I don't know my License Key. This will connect to a form on the Durridge
website, which you can submit to obtain your License Key.



 

Figure 6: The Capture License Window.



  OBTAINING RAD8 AND RAD7 DATA

  This section will provide instructions on connecting the RAD8 and RAD7 to a computer, using
Capture to detect the instrument. It will also cover downloading radon data from the instrument,
and displaying the data in a graph.

Note that Capture 8 Pro customers are eligible to sign up for Capture Cloud, which allows a RAD8
connected to Wi-Fi to automatically upload radon test data to a cloud-based server administered
by Durridge. The data immediately becomes available from within Capture, without the need to
physically connect the RAD8 to a computer. For details, please see the Capture Cloud section.

Setting Up the
Instrument

RAD8 Setup

Make sure the RAD8 contains valid tests, and that it is plugged into a stable power source and
powered On. The included USB-A to Mini-B cable should be used to connect the RAD8 to the
compter. It may be necessary to install USB to Serial adaptor driver software on your computer.
Drivers are available at the Software Drivers page at the Durridge website.

The RAD8's built-in Wi-Fi allows it to communcate with Capture without a USB cable. For more
information, see the Network and Remote Connectivity section.

Figure 1 shows how to connect the RAD8 to a computer using the USB-A to Mini-B Cable.

RAD7 Setup

Make sure the RAD7 contains valid tests, and that it is plugged into a stable power source and
powered On. The included USB to Serial adapter should be connect the instrument to the
computer. It may be necessary to install USB to Serial adaptor driver software on your computer.
Drivers are available at the Software Drivers page at the Durridge website. If the computer has a
physical serial port, it is possible to instead use an RS232 DB9 female to female null modem cable
to connect the RAD7 directly to the computer's serial port.

For wireless RAD7 connectivity, a Bluetooth Serial adapter may be used to facilitate
communication, as explained in the Network and Remote Connectivity section. Durridge offers
preconfigured Parani SD-1000 Serial to Bluetooth Adapters as an optional RAD7 accessory.

Figures 2 and 3 show how to connect the RAD7 to a computer using two different kinds of USB to
Serial adapters: the StarTech adapter (Figure 2), and the Keyspan adapter (Figure 3).

 

Figure 1: Connecting the RAD8 to a computer using the included USB-A to USB Mini-B Cable



Figure 2: Connecting the RAD7 to a computer using the included StarTech USB to Serial Adapter

Figure 3: Connecting the RAD7 to a computer using a Keyspan Adapter

Connecting to the
Instrument

When Capture starts up, the Main Window will appear. This window contains controls used for
downloading radon data from the RAD8 and RAD7, opening existing radon data files from disk,
and performing communication operations. When the Main Window first appears, some controls
will be disabled. These controls become active only when a connected instrument has been
detected.



Figure 4: Scanning for connected devices.

  When Capture launches, it will automatically detect any connected RAD8s, RAD7s, and
DRYSTIKs, as long as automatic device detection can be enabled in Capture's Settings Window.
This option is enabled by default. (Note that a RAD7 must contain RADLINK in order for it to be
detected.) When an instrument is detected, its icon will appear in the toolbar at the top of the Main
Window. Selecting the instrument icon provides access to the device's data and makes it possible
to monitor the device's status.

If Capture does not automatically detect the connected instrument(s), click the Scan For Devices
button at the lower right corner of Capture's Main Window. When Capture is scanning for devices,
a progress bar will appear at the bottom of the Main Window, and any detected instruments will be
added to the window's toolbar, as shown in Figure 4, above.

RADLINK Software for RAD7

Note that Capture can only detect a connected RAD7 if the instrument contains RADLINK
software, as indicated by a functioning Special menu on the instrument. When RADLINK is
installed, it is possible to obtain data from the RAD7 without having to press any buttons on the
instrument itself. If the RAD7 does not have RADLINK installed, or if RADLINK has been damaged,
it may still be possible to download data to Capture, by initiating the data transfer from the RAD7
as explaiend below. RADLINK can be reinstalled, if necessary, by following the instructions in the
RADLINK Operations section. Alternatively, RADLINK will be installed when the RAD7 is returned
to Durridge for calibration. Unlike the RAD7, the RAD8 does not require RADLINK to communicate
with a computer.

If a RAD7 without RADLINK is connected to the computer, click the Add Device button in the
toolbar, which is shown in Figure 5, below, and choose Add RAD7 from the menu that appears.
The Connection Panel will appear, containing controls for specifying the Connection Type, Serial
Port, and Baud Rate, as shown in Figure 6. The Connection Type pop-up menu should be set to
"Serial Port". (The "Network" option is for connecting to a RAD7 at a remote location. This may
require some additional configuration, as discussed in the Network and Remote Connectivity
section.) The Port pop-up menu should be set to the name of the serial port to which the RAD7 is
connected. Finally, the Baud Rate pop-up menu should be set to the baud rate of the RAD7. A
RAD7's baud rate is typically 9600, however for a RAD7 without RADLINK, the baud rate will
always be 1200. After specifying the Port and Baud Rate settings, click the Connect button.



Figure 5: Adding a device manually by clicking the Add Device button.

Figure 6: Specifying connection parameters for a RAD7 that was added manually.

  Note that it is possible to manually connect to a RAD7 even if it has RADLINK installed, however it
is more convenient to let Capture detect it automatically using the Scan for Devices button. If
RADLINK is installed, the RAD7's baud rate may be checked and altered using the RAD7's
keypad. To do this, select the Special menu command on the keypad and press [ENTER], and
then navigate to the SetBaud command and press [ENTER] again. Use the left and right arrow
keys to choose the desired baud rate, and press [ENTER] once again to confirm the selection.
When downloading data manually, whichever baud rate is chosen on the RAD7 must also be
chosen in Capture. If RADLINK is not installed, the Special menu commands will be unavailable
and therefore the baud rate can not be checked on the RAD7, however it can be assumed to be
1200.

Choosing an incorrect baud rate may result in "garbage data" being received. This is generally not
a major problem, since Capture is able to identify such data and it will permit the download to be
interrupted before too much useless information accumulates.

Downloading RAD8
Data

Downloading a RAD8's contents to your computer makes it possible to graph, analyze, and share
the RAD8 data, as well as preserve it against accidental erasure. It is recommended that the data
be downloaded upon completion of each on-site test, or as frequently as is practical.

Along the left side of Capture's main window is a column of icons for connecting to four panels
used for performing common RAD8 communication operations. These include Download RAD8
Data, Chart Recorder, Issue RAD8 Commands, and Relay RAD8 Commands. The Download
RAD8 Data panel will be selected by default.

Select the Download RAD8 Data panel if it is not already highlighted. The following controls will
appear, as shown in Figure 7, below:

RAD8 Tests List: The list box in the left half of the panel contains the names and dates of
the tests stored on the RAD8. An accompanying set of search controls can be used to limit
the list of RAD8 tests based on test name or date range. By default all of the tests on the
RAD8 are listed. The list can be sorted by Name, Date, or File Size, by clicking on the
cooresponding column heading.
Selected Test Information: The top right section of the panel contains information on the
test that has been selected in the RAD8 Tests List. This information includes the average
radon concentration, temperature, humidity, and more.
Graph Preview: A non-interactive graph of the selected test appears in the lower right
section of the Download RAD8 Data panel. A set of buttons below the graph allow the test
data to be saved or opened, as explained below.
Save to Capture Cloud Button: Save the selected test data to Capture Cloud, so that it
can be shared and accessed remotely. (Note that access to Capture Cloud requires
purchasing a Capture Pro license.)
Save Data File Button: Saves the RAD8 test data to the computer. The file wil use the
.RD8 file format. When this file is opened it will appear in a Capture Graph Window.
Open in Graph Window Button: Opens the RAD8 test in an interactive Graph Window,
allowing it to be viewed and analyzed in detail.



Figure 7: Configuring download settings in the Download RAD8 Data panel.

Downloading RAD7
Data

Downloading a RAD7's contents to your computer makes it possible to graph, analyze, and share
the RAD7 data, as well as preserve it against accidental erasure or corruption. It is recommended
that the data be downloaded upon completion of each on-site test, or as frequently as is practical.

Along the left side of Capture's main window is a column of icons for connecting to several panels
used for performing common RAD7 communication operations. These include Download RAD7
Data, Chart Recorder, Issue RAD7 Commands, and Relay RAD7 Commands. After Capture has
connected to a RAD7, a series of brief tests will be performed to determine which communication
operations are possible. The Download RAD7 Data panel is enabled for all RAD7s, and the other
panels will be enabled as long as the RAD7 contains RADLINK.

Select the Download RAD7 Data panel if it is not already highlighted. The following controls will
appear, as shown in Figure 8, below:

Data Type pop-up menu: Use this menu to specify the type of RAD7 data to download;
either a RAD7 Data File or RAD7 Printer Data.
Save downloaded RAD7 data to local disk checkbox: Use this checkbox to specify
whether the downloaded data will be saved to the computer's hard drive. (You will be
prompted to choose the exact location when the download begins.)
Save downloaded RAD7 data to Capture Cloud checkbox: Use this checkbox to
specify whether the downloaded data will be saved to Capture Cloud. This checkbox is only
enabled if you are signed in to Capture Cloud. If you are not signed in, a "Sign In..." button
will appear next to this checkbox. More information is available in the Capture Cloud
section.
Include RAD7 Spectrum Data checkbox: Use this checkbox to specify whether to
include any available spectrum information in the downloaded data. Complete spectrum
information is only available for each cycle if the RAD7 was connected to the computer
while it was recording data. It may take a few moments before this checkbox becomes
enabled, because Capture has to first obtain the necessary information from the RAD7.
Graph Downloaded Data checkbox: Use this checkbox to specify whether to display the
downloaded RAD7 data in a graph window.
Included Records pop-up menu: Use this menu to specify which RAD7 data run(s) to
download. There are four options: Download All Runs, Download Latest Run Only,
Download Specific Run, and Download Range of Runs. If the RAD7 does not contain
RADLINK, this option is disabled.

If RADLINK software is installed on the RAD7, the downloaded RAD7 data file will contain
supplementary information including the RAD7 device identity, thoron data, and run and cycle
numbers, and the file name will use the .R7CDT extension. Files lacking this supplementary data
use the .R7RAW extension. While R7CDT files are somewhat larger on disk than R7RAW files,
both are quite compact and storage requirements should not be a concern.

Be aware that if the Include RAD7 Spectrum Data checkbox is checked, the resulting RAD7 data
file will use a sophisticated text-based format that that does not resemble the RAD7's raw output.



If the Include RAD7 Spectrum Data checkbox is not checked, the data file will use a simple format
consisting of the RAD7's unaltered responses to the basic data download commands. The latter
format is easier to read in a text editor such as Notepad for Windows or TextEdit for macOS.

Figure 8: Configuring download settings in the Download RAD7 Data panel.

  After specifying the appropriate download parameters, click the Begin Download button. You will
be prompted to specify a name and location for the downloaded RAD7 data file. If the RAD7 has
RADLINK, data will begin arriving almost immediately, as shown in Figure 9, below. Otherwise it will
be necessary to start the RAD7 manually.

To start the RAD7 manually, use the RAD7 keypad to choose Data, and then Com. Then key in the
desired run number and press [ENTER]. You will have sixty seconds to complete this procedure
before Capture aborts the download due to an absence of incoming data. The download may be
canceled at any point using the Cancel Download button.

Figure 9: A RAD7 data download operation in progress.

  As data records are received, they will fill a text area at the bottom of the window as shown in
Figure 9. When the data retrieval process is complete, the acquired data will be saved to the



specified location on disk and/or to Capture Cloud. If the Graph Downloaded Data checkbox is
checked, a Graph Window will appear, and it will display the acquired data as shown in Figure 10,
below.

Figure 10: RAD7 data displayed in the Capture Graph Window.

Graphing Radon Data The Graph Window displays radon concentration data across a timeline, with higher radon
concentrations plotted higher on the graph image. In addition to radon, a graph may display
thoron, temperature, and humidity data. A multitude of controls are available for navigating RAD8
and RAD7 data graphs, as discussed in the Graph Window Navigation section. Graph data can
be configured to reflect particular radon test protocols involving radon-in-water accessories; this is
discussed in the Setting Test Parameters section.

Typically the data displayed in the Graph Window is stored on disk or in Capture Cloud, so it is
possible to reopen it at any time. If data is stored on disk, it can be reopened using the Open Data
File button on the toolbar, or the Open Data File... command in the File menu. If data is stored in
Capture Cloud, it can be retrieved using the Capture Cloud panel in the Main Window.

Graph data and graph images can be exported and printed for use in spreadsheets and
presentations using the Export commands in the File Menu. For more details, please see the Data
Export, Reports, and Printing section.

  When the Graph Window opens, it may be necessary to specify certain parameters which affect
the interpretation of the data. For RAD8 data these are referred to as the Test Parameters, and for
RAD7 data these are referred to as the Run Parameters. For most projects it will be appropriate to
leave these parameters at their default settings, but if the radon data was collected with the use of
certain Durridge accessories such as the RAD AQUA, Water Probe, or Big Bottle System, then
some configuration will be required. This is done using the Test Parameters Window (for RAD8
data) or the Run Parameters Window (for RAD7 data). Please see the Setting Test Parameters
Section for more details.

Downloading From All
RAD7s

Capture makes it easy to quickly download all of the data from each connected RAD7. Once the
RAD7s have been discovered, the Download Data From All RAD7s command will become enabled
in the Options menu located on the Main Window toolbar.

After selecting Download Data From All RAD7s, the dialog box pictured in Figure 11 will appear.
Click the Select Download Location... button to select the folder into which the RAD7 data will be
saved. Next click the Begin Download button. As data is obtained, a message on the lower left
corner of the window provides details on the progress.

Once all of the data has been downloaded, the Begin Download button caption changes to Show
Downloaded Files. Clicking this button closes the dialog box and opens the folder containing the
downloaded files.

 



Figure 11: Downloading data from all connected RAD7s.



  GRAPH WINDOW NAVIGATION

Opening Data in a
Graph  

The Graph Window appears when radon test data is downloaded from a RAD8 or RAD7, or when
test data is opened from either the computer's disk or the Capture Cloud Browser. To open a
RAD8 or RAD7 data file from disk, either choose "Open Data File..." from the File menu, or click the
Open Data File button on the Main Window toolbar, which is shown in Figure 1, below. To open
test data from Capture Cloud, go to the Capture Cloud Browser and double-click on an item in
the list of search results.

The Home panel in Capture's Main Window contains an Open Data File button and an Open
Recent pop-up menu. A list of recently opened files appears when this button is clicked. This list is
also available through the Open Recent command in the File menu. Up to ten recently opened files
will be remembered, with the newest items placed at the top of the list. RAD8 and RAD7 data files
may also be opened by dragging them onto the Capture application icon, or by simply double-
clicking them.

 

Figure 1: The Main Window Toolbar containig the Open Data File... button.

RAD8 and RAD7 data files are selected using the standard system Open dialog box. RAD8 data files
use the .RD8 file name extension, and RAD7 data files typically use the .R7CDT file name extension.
In each case the file will have an icon indicating its file type. (Information on the various types of
RAD8 and RAD7 Data Files is available in the File Formats section.) Once a radon data file has been
chosen, it will be opened in a new Graph Window.

If you wish to open one of the included sample radon data files, choose Open Sample Data File from
the File menu, and use the submenu to select one of the available built-in sample files.

If there are problems with the data but it is still usable, Capture will graph only the valid data records,
and a list of errors will be made available. More information on handling problematic data is available
in the Radon Data Errors section.

  The Graph Window may appear when new radon test data is downloaded or when an existing
radon data file is opened.

The Graph Window   The Graph Window consists of several interface components, including side panels containing
navigation controls, a Spectrum display, and Statistics. Each of these elements are described below.
Note that the Graph Window's navigation controls and statistics panel will differ slightly based on
whether RAD8 data or RAD7 data is being displayed.

The Graph Window displays radon data along a coordinate plane, with the X axis representing time,
and the Y axis indicating the radon concentration in any of several different unit types. Radon data
itself appears as a black line by default. When RAD7 data is being graphed, data records with high
relative humidity values will appear in red. (Relative humidity is abbreviated RH. The line color can be
changed in the application settings.) Additional graph lines, representing such things as thoron
concentration, air temperature, and humidity, may be toggled on and off within the Graph Controls
panel, which appears along the left side of the Graph Window. This is explained further below. Gaps
in the data occur in areas where no radon samples were recorded.

CAPTURE

FileEditViewToolsWindowHelp

Home CAPTURECLOUDOpenDataFile...
+

AddDevice Options Event-DrivenActions



Figure 1: The Graph Window

Basic Navigation   The Graph Window contains simple but powerful navigational controls which make it possible to
select data points, scroll horizontally through data, and zoom the graph.

Selecting Data

To view a specific portion of the graph in detail, it is first necessary to adjust the selection. The vertical
blue lines in the above screen are called Selection Bars. These lines frame the selected area.
Information pertaining to the selected data points is displayed under the "Selected Area" heading in
the Statistics panel, which is located alongside the Graph Window. To create a new selection, simply
drag the mouse cursor across a portion of the graph. The selection can then be modified by dragging
either of the Selection Bars. Dragging while holding the Alt (Option) key will cause the selection to
grow from the center.

Zooming the Graph

Drag the selection bars to the desired locations and double-click to zoom the view to the selected
region. Once the view has been magnified, the selected data will be visible in greater detail, and a red
bar will appear under the Selection Bars. Double-clicking on the Selection Bars when they are red
causes the view to zoom out to its previous state. If the red Selection Bars are dragged, they will turn
blue again and the selection may be changed. At that point, double clicking will cause the view to
zoom in further for still greater detail.

Zooming in and out may also be achieved by using the Zoom Slider which is located on the floating
Graph Controls panel, which appears to the left of the Graph Window by default. (The Graph Controls
panel is described in greater depth below.) Additionally, the View menu in the menu bar contains Zoom
In and Zoom Out commands, which can be used repeatedly to move in and out through a wide range
of zoom states.

Scrolling the Graph

Whenever the graph is zoomed in, the scroll bar at the bottom of the window will become enabled,
and it will be possible to navigate forwards and backwards through time.

It is also possible to scroll the graph using the Selection Bars. Position the cursor between the
Selection Bars, and hold the Shift key. With the Shift Key pressed, drag the mouse to the left or right,
off the edge of the graph. The graph will scroll to keep up with the movement of the mouse.



Graph Controls
Panel  

The Graph Controls panel is used to navigate the graph and change its behavior and appearance.
Although much of its functionality is also accessible from within the menu bar, you may find that the
Graph Controls panel provides easier access to commonly used functions. This scrollable panel
consists of a series of sub-panels, labeled Configuration, Appearance, Navigation, Graph Lines, and
Windows and Panels. Each may be expanded or collapsed by clicking on its heading. The sub-panels
are described below.

Configuration Panel

Figure 2: The Configuration Controls Panel

Profile Pop-Up Menu

RAD8 Profiles and RAD7 Profiles contain sensitivity information and spill factor values that allow radon
data to be more accurately parsed and presented. Capture maintains a collection of instrument
Profiles, and they are created automatically as needed. When a radon data file is opened, Capture will
select the appropriate profile, with respect to which instrument produced the data, and when the data
was recorded. This selection may be overridden if desired using the Profile pop-up menu. The
collections of RAD8 Profiels and RAD7 Profiles may be edited in the Settings Window, as described in
the Settings Window section.

Concentration Units Pop-Up Menu

Determines the unit of measurement used to denote radon and thoron concentrations on the graph.
The available options include Automatic, Bq/L, Bq/m3, dpm/L, and pCi/L. The Automatic option
causes radon and thoron concentrations to be presented in the unit in which they were originally
recorded on the instrument.

Temperature Units Pop-Up Menu

Determines the unit of measurement used to denote air and water temperatures on the graph. The
available options include Automatic, Celsius, Fahrenheit, and Kelvin. The Automatic option causes
temperatures to be presented in the unit in which they were originally recorded on the instrument.

Forced Rapid Analysis Mode Checkbox (RAD8)

Determines whether RAD8 data is forced to be displayed as if it had been recorded in Rapid Analysis
Mode, in which the radon concentration is calculated based on the counts that occurred in the
Spectrum's A Window, even if it had originally been recorded in Precise Analysis Mode, in which the
calculation is based on the counts in both the A Window and the C Window.

Forced SNIFF Mode Checkbox (RAD7)

Determines whether RAD7 graph data is forced to be displayed as if it had been recorded in SNIFF
Mode. This checkbox is enabled whenever the RAD7's SNIFF sensitivity information is present in the
data file. Note that the term SNIFF Mode is used only for RAD7 data. For RAD8 data, the equivilant
term is Rapid Analysis Mode.

Correct For Humidity Checkbox

Determines whether the graph data is corrected for humidity. When the humidity is high, the RAD8
and RAD7 operate at reduced efficiency, and radon concentration values are therefore underreported.
Humidity correction compensates for this using empirically determined formulae.

Correct for B to A Spill Checkbox

Determines whether correction is applied based on the spill from the B to A windows. Significant spill
may occur when the thoron concentration is high relative to the radon concentration. Under these



conditions it is recommended that the data be corrected to compensate.

Appearance Panel

Figure 3: The Appearance Controls Panel

Point Style Pop-Up Menu

Determines the appearance of the data points on the graph. The options are Normal, Shapes, B&W
(Black and White) Shapes, and Hidden. The B&W Shapes option causes the graph to be rendered in
black and white, which is useful when graph image is printed on a non-color printer.

Line Weight Pop-Up Menu

Determines the thickness of the graph lines, as measured in pixels. This value may range from 1 to 4,
or the graph lines may be hidden. A thicker line may be easier to read, but is somewhat less precise
than a single-pixel line.

Smoothing Pop-Up Menu

Determines the degree of smoothing applied to the graph line. This value may range from 1 (no
smoothing) to 9 (high smoothing). When the degree of smoothing is greater than 1, the original, non-
smoothed graph line appears faded in the background.

Show Grid Lines Checkbox

Determines whether horizontal and vertical grid lines are visible on the background of the graph. Grid
lines are drawn at regular intervals, with vertical lines representing time intervals, and horizontal lines
representing concentrations, temperatures, and humidity levels.

Show Graph Legend Checkbox

Determines whether the legend is visible on the Graph Window. The legend indicates the meaning of
the colors that appear on the graph. To the right of the Show Graph Legend Checkbox is a small
control for setting the position of the Graph Legend. It may be placed in any of the four corners of the
graph image.

Show Error Bars Checkbox

Determines whether error bars are visible on the graph. Error bars are vertical line segments which
pass through data points, indicating the uncertainty of radon and thoron readings.

Show Selection Average Checkbox

Determines whether a representation of the average of the selection is displayed between the
Selection Bars. A horizontal line represents the average of the selection, and a shaded region
represents the uncertainty of the average. Separate representations appear for Radon, Thoron, Radon
in Water, and Thoron in Water.

Show Selection Slope Checkbox

Determines whether the Selection Slope Line is visible on the graph. This checkbox may be checked
or unchecked, or it may be set to an intermediate partially checked state, in which case the Selection
Slope Line only appears if the selection contains a series of fairly evenly distributed data points. The
Selection Slope Line starts at the first Selection Bar and ends at the second Selection Bar. The default
angle of the Selection Slope Line is based on a linear regression formula accounting for the distribution
of the selected data points. However the line's endpoints may be dragged manually to modify the
position and angle of the line if desired. If the line is adjusted manually, it will change from blue to red
to indicate that a modification was made. The line's slope is stated in the Statistics panel, where it is



expressed as a change in radon or thoron concentration per unit of time. The pop-up menu control to
the right of the Show Selection Slope Checkbox is used to specify the time unit used in this
expression. The time unit may be set to either Automatic, Months, Days, Hours, Minutes, or Seconds.

Navigation Panel

Figure 4: The Navigation Controls Panel

Graph Zoom Slider

Zooms the radon graph in and out. When this slider is dragged all the way to the left, the entire
collection of data is made visible, and no horizontal scrolling is required to see data points.

Concentration Scale, Temperature Scale, and Humidity Scale Pop-Up Menus

The Radon Concentration Scale pop-up menu determines whether the Y scale of the radon graph is
determined automatically or manually. If Automatic is selected, the graph's Y scale will be configured
such that the visible radon points will occupy the entire available vertical space. Selecting Manual
makes it possible to control the Y scale region yourself.

Also appearing in the Navigation panel are pop-up menus for specifying the Thoron Concentration
Scale, the Temperature Scale, and the Relative Humidity scale. Each behaves similarly to the Radon
Concentration Scale pop-up menu, and may be set to either Automatic or Manual.

Scale High and Low Fields

When a Concentration Scale, Temperature Scale, or Humidity Scale pop-up menu is set to Manual, a
set of controls for specifying the scale parameters appears. The High and Low fields represent the
highest and lowest element values visible on the graph respectively. Separate sets of High and Low
fields are present for Radon, Thoron, Temperature, and Relative Humidity.

Scale Zoom and Scroll Sliders

To the right of each pair of High and Low fields are a set of controls for zooming and scrolling the
graph's Y Scale. The Zoom Slider, on the left, is controlled by clicking or dragging the filled region to
the desired level; higher levels represent increased zoom. The Scroll Slider, on the right, operates like
any scroll bar; simply drag the box up or down until the desired region scrolls into view. The height of
the scroll box is proportional to the scope of the currently visible region. As with the High and Low
fields, separate sets of Zoom and Scroll sliders are present for Radon, Thoron, Temperature, and
Relative Humidity.

Graph Lines Panel



Figure 5: The Graph Lines Controls Panel

Radon in Air Checkbox

Determines whether radon data is shown on the graph. The values of the radon data points may be
affected by any corrections applied in the Configuration panel, as described above.

Thoron in Air Checkbox

Determines whether Thoron data is shown on the graph. Thoron data may remain hidden if the
instrument was operating in a protocol known to produce invalid or misleading thoron concentration
readings. Note that this is more common with RAD7 data than RAD8 data. If Thoron data does not
appear when the box is checked, a button labeled "Thoron Info" will appear at the upper right corner
of the Graph Window. Clicking this button will provide an explanation as to exactly why Thoron is not
visible, and the option to display Thoron anyway will be made available.

Radon In Water Checkbox

Determines whether radon in water data is shown on the graph. This checkbox may only be enabled if
water temperature information has been supplied along with the RAD8 or RAD7 data. This
temperature information is necessary for plotting RAD AQUA and Water Probe data.' instead.

Thoron In Water Checkbox

Determines whether thoron in water data is shown on the graph. As with the Show Thoron checkbox,
clicking this box may result in the "RAD8 (or RAD7) Profile: Thoron Settings" dialog or "Thoron Details"
button appearing. As with the Radon In Water checkbox, this box is only enabled if water temperature
data has been provided along with the basic RAD8 or RAD7 data.

Air Temperature Checkbox

Determines whether air temperature data points are visible on the graph. The temperature unit used
here may be set in the Configuration panel, as described above.

Water Temperature Checkbox

Determines whether water temperature data is visible on the graph. As with the Radon In Water
checkbox, this box is only enabled if water temperature data has been provided along with the basic
RAD8 or RAD7 data.

Relative Humidity Checkbox

Determines whether relative humidity data is visible on the graph. Relative humidity values are stored
as whole integers. When viewing RAD7 data (but not RAD8 data), areas of excessive humidity will be
identified with a differently colored radon graph line.

Meaningful Thoron Threshold Checkbox

Determines whether a shaded area will appear representing the area below the meaningful thoron
concentration range. A thoron reading may only be considered meaningful if the data point appears
above this shaded area. If one or more thoron data points are found to be under the minimum
concentration threshold, an error message will be recorded, explaining the situation. Non-meaningful
thoron data has high uncertainty, resulting from excessive spill between the RAD7's C and B windows.
The Meaningful Thoron Threshold checkbox is only enabled if Thoron or Thoron in Water points are
being displayed on the graph. If both Thoron and Thoron in Water points are visible, two shaded
regions will be rendered.

Windows and Panels



Figure 6: The Windows and Panels Controls Panel

Show Log Window Checkbox

Determines whether the Log Window is visible. This window contains a listing of all of the actions that
Capture has performed since the application was launched, plus a record of the data that has arrived
through each serial port.

Show Spectrum

Determines whether the Spectrum panel is visible. This panel displays a histogram of alpha decay
event energies that forms the raw data from the RAD8 or RAD7.

Show Statistics

Determines whether the Statistics panel is visible. This panel displays a range of information on the
data being displayed on the graph, as well as whichever data lies within the selected portion of the
graph.

Statistics Panel   The Statistics panel consists of four sub-panels; the first contains RAD8 or RAD7 hardware
information; the next three sub-panels contain information on the entire data range, the selected area,
and the point nearest to the cursor, respectively. Each of these may be independently expanded or
collapsed as viewing area permits. The Statistics panel itself may be resized and scrolled as desired.
The contents of each sub-panel are described below.

RAD8 or RAD7 Hardware Information Panel

Figure 7: The RAD7 Hardware Information Panel

The first sub-panel in the Statistics panel shows information about the RAD8 or RAD7 from which the
current graph data was obtained. Its heading contains the instrument's serial number. Note that in the
case of the RAD7, this may be listed as '[Unknown]' because not all RAD7 data files contain
supplementary information with details on the device itself. Typically files with the R7CDT file name
extension offer this supplementary data, while files with the R7RAW file name extension do not.

The Sensitivity and Spill Factor values displayed in this panel are generally obtained from the RAD8 or
RAD7 data file, but they may also be obtained from an applied RAD8 or RAD7 Profile. If a Sensitivity or
Spill Factor value is obtained from a RAD8 or RAD7 Profile and it differs from the value present in the
radon test data itself (or if no such value is present in the test data), then the stated value will be
marked with an asterisk (*).

Entire Data Range Statistics Panel

The second sub-panel in the Statistics panel contains information on the application and platform
used to obtain the data, and a summary of the entire range of data represented in the graph, including



the average radon concentration, thoron concentration (if applicable), temperature, and humidity, as
well as the total number of data points and time duration of the data set.

Figure 8: The Entire Data Range Statistics Panel

Selected Area Panel

The third sub-panel in the Statistics panel displays information on the selected records, i.e. those lying
between the two Selection Bars. This includes the selection's average radon concentration, average
thoron concentration (if applicable), average temperature, and average humidity, as well as information
on the Selection Slope, the number of data points selected, and the time duration of the selected
range.

Note that the average concentration of the selected data points is also reported along the top of the
Graph Window, directly above the graph image. Clicking on this text toggles between displaying the
average concentration of the selection and the standard deviation of the selection. By default, the
standard deviation indicates the amount of variation between the selected data points.

Figure 9: The Selected Area Statistics Panel

Point Nearest To Cursor Panel

The fourth sub-panel in the Statistics panel displays statistics on the data record that is closest to the
mouse cursor. This includes the record's date, record number, run number (in the case of RAD7 data),
and test/cycle number, plus radon and thoron concentrations and counts, as well as temperature and
relative humidity data. Information on the state of the RAD8 or RAD7 at the time of the test is also
provided. If the graph contains raw RAD7 data lacking supplementary information, the Run and Cycle
values will not be listed. Any problems with the data point will be reported in the bottom section of the
panel.



Figure 10: The Point Nearest to Cursor Statistics Panel

Spectrum Panel   The Spectrum panel displays a histogram indicating the distribution of counts across a range of
channels, or alternatively a bar graph indicating the distribution of counts across a set of windows. It
contains buttons for toggling between three display formats:

1. Spectrum histogram for the selected data points
2. Cumulative Spectrum histogram for the selected Test (or Run)
3. Bar Graph for the selected data points

The Spectrum histogram for the selected data points resembles the spectrum printed by the thermal
printer at the end of each RAD8 test (or RAD7 run), except it only applies to the selected points, rather
than the entire test (or run). The Cumulative Spectrum matches the one printed by the thermal printer
at the end of each test (or run). The bar graph shows the rate of counts being recorded in each of the
main windows, A, B, C, D, and O, for the selected data points.

For RAD7 data, the Spectrum histogram for selected data points is only available if Capture was open
and the Chart Recorder was running when the selected data cycles were recorded. This is because
the spectrum count data increments in the RAD7's memory at the end of each cycle, and the Chart
Recorder captures this spectrum data and saves it before it is overwritten. This limitation does not
apply to the RAD8, which preserves all of the spectrum data for each cycle. The Cumulative Spectrum
display option is available in all cases for RAD8 data; this option is available for RAD7 data in cases
where Capture downloads the data after the completion of the selected run, and before the start of a
subsequent run. The Bar Graph display option is available in all cases for both the RAD8 and RAD7.

The histogram displays show all of the channels relevant to radon and thoron measurements. The
"Low Noise" Channels are omitted from the display, whereas the channels encompassing Windows A,
B, C, and D, are displayed in full detail whenever possible, revealing the total counts in each channel
for either the selected data points or the selected run. The count rate is displayed under each peak,
and the name of the polonium isotope whose decays contributed to the peak is displayed at the top.

Capture's Spectrum display is useful for visualizing the growth of counts in window C as time
progresses in a measurement run. It is also useful for identifying a pathological spectrum that may be
generated by a malfunctioning RAD8 or RAD7. In a pathological spectrum the peaks may not be in
their correct positions, and there may be spurious points within and outside the primary windows that
are distributed randomly across the entire spectrum, as described in Section 4.12.4 of the RAD8
manual (Section 3.13.4 of the RAD7 manual). More information on the spectrum is available in Section
4.6 of the RAD8 User's Manual, and Section 3.7 of the RAD7 User's Manual.

Note that the Spectrum panel should not be confused with the contents of the Chart Recorder
Spectrum, which displays a spectrum representing the current state of a RAD8 or RAD7 connected to
the computer.



Figure 11: The Spectrum Panel showing a histogram for the selected data points

Figure 12: The Spectrum Panel showing a bar graph for the selected data points

Annotations An annotation is a text note that can be pinned to a particular data point, or to specified date on the
graph timeline. Figure 13 shows an annotation that has been pinned to a data point. To create an
annotation, use the Add Annotation command in the File Menu, or right-click on the desired part of the
graph (Control-click on macOS) and choose Add Annotation from the contextual menu. The Edit
Annotation Window will appear as shown in Figure 14, below.

In the Edit Annotation Window, specify the desired name, color, text content, and date parameters.
The specified name will appear at the top of the annotation in a white title bar, and the chosen color
will appear behind the underlying text content, as shown in Figure 13. If the Pin to Data Point radio
button is selected in the Edit Annotation Window, the annotation will contain a triangular arrow
pointing to the data point and element types that are specified in the accompanying pop-up menus. If
the Pin to Date radio button is selected, the Annotation will appear at the top of graph image, at the
specified date and time.

The Create searchable Data Tag based on Annotation Name checkbox is used to add a data tag that
makes the RAD7 data file easier to find in the Capture CLOUD Browser. For more on data tags, see
Searching With Data Tags in the Browsing Capture Cloud Data section. When finished specifying the
annotation properties, click the OK button.

To edit or remove an existing annotation, click its edit button, which is located at the top right corner
of the annotation on the graph. The Edit Annotation Window will reappear. It contains a Delete
Annotation button that can be used to remove the annotation. After an annotation has been added,
modified, or deleted, the Save command will be enabled in the File menu. When the file is saved, the
included annotations will be preserved, and will be visible when the file is reopened.



Figure 13: An annotation pinned to a graph data point.

Figure 14: The Edit Annotation Window



  SETTING TEST PARAMETERS

The Test Parameters
Window

RAD8 data sets are assigned Test Parameters, which keep track of a Radon Measurement Method
for each test and determine how the data is interpreted by Capture. The Default Radon
Measurement Method is Radon In Air, and the Graph Window therefore typically displays radon in
air data.

Similarly, RAD7 data sets contain Run Parameters, which keep track of a Radon Measurement
Method for each run

If a Graph Window is displaying radon data that was acquired using a water-related accessory
such as the RAD AQUA, RAD H2O, Big Bottle System, or Water Probe is used, it is necessary to
specify the Radon Measurement Method using the Test Parameters Window (for RAD8 data) or the
Run Parameters Window (for RAD7 data), as shown in Figure 1, below. To open the this window,
drag the graph selection bars to select a series of contiguous data points and choose the Test
Parameters (or Run Parameters) command in the File Menu. Alternatively, click the pencil icon on
the label that appears above the start of a series of data points on the graph. The Test Parameters
(Run Parameters) Window is used to set properties needed to calculate the concentrations of
radon in water.

This window contains a pop-up menu for choosing whether to apply changes to only the selected
test(s)/run(s), or to All Tests/Runs (provided the data set consists of multiple tests/runs). An
accompanying pop-up menu is used to specify the Radon Measurement Method. For graphing
conventional radon data, the Radon Measurement Method should be set to Radon in Air, which is
the default setting for most data sets.

Note that once the parameters of one or more tests/runs have been modified, the Save command
will become enabled in the File Menu. If the Test (Run) Parameters have been modified and an
unsaved file is closed, Capture will display a Save prompt, providing the opportunity to save the
modified file before it is closed. When the file is reopened, any changes that have been saved will
be restored.

 

Figure 1: The RAD7 Run Parameters Window, used for specifying the Radon Measurement Method.

Radon In Water If the RAD8 or RAD7 was monitoring radon in water with the aid of a RAD AQUA, Water Probe, or
Big Bottle System accessory, it will be necessary to use the controls in the Test (Run) Parameters
Window to specify the Water Type and Water Temperature.

The Water Type may be set to either Fresh Water or Saline Water. When Fresh Water is selected,
the radon-in-water concentration is calculated using the Fritz Weigel formula, which is a function of
temperature alone. (See Weigel, F. Radon. Chemiker-Zeitung 1978, 102 (9), 287-299.) When Saline
Water is selected, the radon-in-water concentration is calculated using the Schubert et al. formula,
which is a function of both temperature and salinity. Note that this formula is suitable for water
samples with any degree of salinity, including zero. (See Schubert et. al. Environ. Sci. Technol.



2012, 46, 3905-3911.) If Saline Water is chosen, the water salinity value must be expressed in
terms of parts per thousand (‰).

The Water Temperature information can be provided by a Temperature Data File. It can also be set
to the Air Temperature (optionally shifted by a particular offset), or to a Fixed Temperature Value.
Additionally, on computers running the Windows operating system, water temperature information
can be obtained directly from a Temperature Data Logger. Once water temperature information has
been applied to a radon data file, an additional Water Temperature Source option will become
available: "Existing Temperature Data". The Water Temperature Source options are described
below.

Temperature Data File
Temperature data files are text-based files containing columns of dated entries listing temperature
values over a period of time. Capture matches these temperature readings to RAD8 and RAD7
records in order to calculate radon-in-water concentrations. Temperature data files are created
using third party software provided with temperature logging devices. Capture includes built-in
support for several logger file formats, but it is also possible to define custom Temperature Data
Profiles to accommodate file formats for which Capture lacks built-in support.

Air Temperature
If complete water temperature data has not been collected, Capture can be instructed to assume
that the water temperature matches the air temperature data that is recorded by the RAD8 or
RAD7 whenever it is active. If it is known that the water temperature is consistently higher or lower
than the ambient air temperature, a temperature offset may be assigned. Basing the water
temperature on the air temperature is less accurate than obtaining comprehensive water
temperature data from a logger device, but it can be a convenient way to obtain acceptable results
in the absence of water temperature data. Try adjusting the assumed offset and see for yourself
the degree to which the calculated radon-in-water results are affected.

Fixed Temperature Value
The simplest way to provide Capture with water temperature data is to specify a fixed water
temperature value which will be assigned to every record on the graph. This approach is suitable if
the water temperature has been determined and is known not to have changed significantly
throughout the duration of the experiment.

EL-USB-TC Temperature Logger
Capture can also obtain water temperature data directly from an EL-USB-TC temperature logger
connected to the computer via USB. Once obtained, the data may be saved to disk as a
Temperature Data File, for easier future access. Note that this functionality requires drivers which
are obtained by installing the EasyLog USB software for Windows. (See the Lascar website at
https://www.lascarelectronics.com.) These drivers are not available for macOS.

To configure RAD8 or RAD7 data recorded using the RAD AQUA, Water Probe, or Big Bottle
System, select the appropriate accessory from the Radon Measurement Method pop-up menu.
Next select the Water Type, and specify the Salinity value if necessary. Then choose the Water
Temperature Source, as shown below:

Figure 2: The Water Temperature Source pop-up menu in the RAD7 Run Parameters Window.

If the Water Temperature Source is set to Temperature Data File, the screen shown in Figure 3 will
appear. Click the Temperature Data File... button and select the file, which should be stored on
disk. Next use the Temperature Data Profile pop-up menu to specify which profile should be used
to read its data. Capture contains built-in profiles for several common formats used in files



exported from Onset Computing's BoxCar and HOBOware software, and EasyLog software.
Profiles for other formats must be defined manually. The process of creating new Temperature Data
Profiles is explained in the Settings Window section.

 

Figure 3: The RAD7 Run Parameters Window with the Radon Measurement Method set to a radon-in-water accessory
that requires a Water Temperature Source. Here the Water Temperature Source has been set to a Temperature Data
File.

  If the Water Temperature Source pop-up menu is set to Air Temperature, the only further action
required is to specify the Water Temperature Offset, as shown in Figure 4. The specified number of
degrees (Fahrenheit or Celsius) will be added to the air temperature recorded by the RAD8 or
RAD7 to determine the presumed water temperature. Typically a small negative number will be
used.

 

Figure 4: The RAD7 Run Parameters Window with the Radon Measurement Method set to a radon-in-water accessory
that requires a water temperature source. The Water Temperature Source has been set to the Air Temperature.

  If the Water Temperature Source pop-up menu is set to Fixed Temperature Value, simply specify
the water temperature and unit (either Fahrenheit or Celsius), as shown in Figure 5.

 



Figure 5: The Test (Run) Parameters dialog with the Radon Measurement Method set to a radon-in-water accessory
that requires a water temperature source. The Water Temperature Source has been set to a Fixed Temperature Value.

  If EL-USB-TC Temperature Logger is selected in the Radon Measurement Method pop-up menu,
as shown in Figure 6, make sure an EL-USB-TC Temperature Data Logger is connected to the
computer via USB. Use the Save Logger Data to Disk checkbox to specify whether the
temperature data will be saved to disk after it has been obtained. This may be desired but it is not
necessary, because the water temperature data will be stored in the RAD8 or RAD7 data file itself
and saved accordingly. Downloading data from a temperature logger takes several seconds. To
ensure optimal performance, the device should be set to log temperature readings no more
frequently than once per minute.

After the appropriate settings have been selected, click the OK button. The graph will display
Radon-in-Water data, and in some cases it will be possible to display Thoron in Water and Water
Temperature data as well.

To avoid having to assign water temperature data every time the graph is opened, use the Save or
Save As command to save the file after the desired changes have been made.

Details for each radon-in-water accessory are discussed below.

 

Figure 6: The RAD7 Run Parameters Window with the Radon Measurement Method set to a radon-in-water accessory
that requires a water temperature source. The Water Temperature Source has been set to the EL-USB-TC
Temperature Logger.



RAD AQUA and Water
Probe 

Capture handles data obtained using the RAD AQUA and Water Probe accessories similarly. In
each case the Radon Measurement Method should be set to the appropriate accessory, and it is
necessary to specify a Water Temperature Source, which may be set to any of the four options
discussed above. It is recommended that temperature data be obtained from a Temperature
Logger or from an existing Temperature Data File, but the other options may be acceptable if
precise temperature information is unavailable.

After clicking the OK button, the graph will be updated, and it will become possible to view a
Radon-In-Water graph line. In the case of the RAD AQUA, Thoron in Water data will also be
available. Water Temperature data will be viewable in all cases.

Big Bottle System  If the radon data being graphed was obtained with the use of the Big Bottle System accessory,
then it will be necessary to specify the water temperature data as described above, as well as
additional information on the specific Big Bottle System configuration used to aerate the water
sample and obtain the radon data.

To graph radon data collected with the use of the Big Bottle System, first choose Big Bottle
System from the Radon Measurement Method pop-up menu, as shown in Figure 7, below. Specify
a Water Type and configure the water temperature parameters as described above.

Next specify the RAD8 Type or RAD7 Type. In the case of the RAD7, this may be a standard
RAD7, a RAD7 with an oversized dome, or a Custom RAD7. If Custom is selected, it becomes
possible to specify the RAD7's internal air volume in the field below the RAD7 Type pop-up menu.
In the case of the RAD8, the options are limited to Standard RAD8 and Custom RAD8. After
selecting the appropriate instrument type, select the Drying Unit that was used. It may be one of
the following:

Laboratory Drying Unit
Small Drying Tube
Custom
None

If a Custom drying unit is selected, it is necessary to specify the volume of the drying unit in
milliliters.

Next, specify which kind of DRYSTIK, if any, was present in the experimental apparatus. Different
DRYSTIK models have different internal air path volumes, which must be accounted for when
calculating radon concentrations.

It is also necessary to specify the parameters listed below, which pertain to the air volume inside
the testing apparatus (Many of the parameter fields are pre-populated with sensible default values:

Tubing+Aerator Cap Volume: The combined volume of all the tubing and aerator cap.
Bubble Trap Volume: A Bubble Trap is only needed in older Big Bottle systems with Aerator
Cap Revision B.
Head Space: The air space above the water in the bottle. When using a glass bottle, a small
amount of head space should be left to prevent the thermal expansion of water from
breaking the bottle. It is less necessary to leave head space when using a soda bottle.
Bottle Volume: The volume of the standard glass jug is 2.5 L. Soda bottle volumes vary.
Brim-Full Water Loss: The volume of water displaced and lost from the bottle when inserting
the aeration tubing.
Aeration Efficiency: The degree to which the water sample was aerated. In most cases,
100% is the most appropriate choice, as it indicates that the aeration was sufficient to
achieve full equilibrium. Extreme caution should be used when modifying this parameter.



Ambient Radon: The concentration of radon in the outside air.

The Preset Configurations pop-up menu at the bottom of the window can be used to select from
several typical configurations, involving a variety of common bottle sizes and aerator types.
Choosing a preset configuration causes several fields to be automatically populated with the
appropriate values.

Note that Capture does not allow the user to specify a configuration in which the Drying Unit,
DRYSTIK, and Bubble Trap are absent and the aerator cap is of an insufficient volume, because
experiments involving such a setup would present a high risk of water entering the RAD8 or RAD7.

After the appropriate settings have been entered, click the OK button. The graph window will then
permit the display of Radon in Water and Water Temperature graph lines, which are unavailable in
conventional graphs. The graph should indicate a radon-in-water concentration somewhat different
than the Radon In Air concentration, as shown in Figure 8. Because of thoron's very brief half life, it
is not possible to graph Thoron in Water concentrations obtained using the Big Bottle System. See
the Big Bottle System manual for detailed information on interpreting this data, and the Graph
Window Navigation section for more information on Capture's graphing features.

 



Figure 7: The RAD7 and RAD8 Run Parameters Window with the Radon Measurement Method set to Big Bottle
System, used for graphing radon-in-water data obtained through the Big Bottle System accessory.

 



Figure 8: Typical graph of data obtained with the use of the Big Bottle System accessory. Radon in Water is represented
by the blue graph line. The selected area represents the crucial 20-60 minute range.

RAD H2O  When opening radon data that was recorded using the RAD H2O accessory using the appropriate
RAD H2O Protocol, the Radon Measurement Method will automatically be set to RAD H2O, so
there is no need to open the Test (Run) Parameters Window.

When the graph appears, the Radon-In-Water graph line may be displayed, revealing valid WAT
mode data points. Since water temperature data is not needed for computing RAD H2O radon
concentrations, the Water Temperature graph line will be disabled. The Thoron In Water graph line
will also be unavailable, because the brief half life of thoron means it will be undetectable by the
time the water sample is aerated using the RAD H2O.

See the RAD H2O manual for detailed information on interpreting this data, and the Graph Window
Navigation section for more information on Capture's graphing features.

 

Figure 9: The RAD7 Run Parameters (RAD8 Test Parameters) Window with the Radon Measurement Method set to
RAD H2O, used for graphing radon-in-water data obtained through the RAD H2O accessory.



Note that Capture includes a stand-alone window for calculating a radon-in-water concentration
based on user-provided information including the Radon in Air concentration, Water Type and
Water Temperature. To access this window, use the Tools menu in the menu bar to select Radon-
In-Water Calculator. This feature is used to calculate a single radon-in-water concentration, and it
does not display a graph. See the Menu Commands section for details.



  THE CHART RECORDER

  The Capture Chart Recorder displays a real-time graph of RAD8 or RAD7 data as it is recorded. As
a radon test progresses, a set of virtual pens plot radon concentration, temperature, and humidity
data. The chart slowly scrolls to the left in real time, so that the right edge of the chart represents
the current time.

The Chart Recorder contains a button bar for starting and stopping tests and configuring
instrument settings. Below the Button Bar is a Status Display panel which indicates the current
state of the selected RAD8 or RAD7. A nearby panel of Chart Recorder Controls is used to adjust
the appearance and range of the Chart Recorder. These features and others are described in detail
below.

Figure 1: The Capture Chart Recorder.

Chart Button Bar  The Chart Recorder's Button Bar contains controls for refreshing the Status readout and
configuring chart settings. When viewing a RAD7 chart, controls are also provided for starting and
stopping the RAD7 and configuring the instrument.

Figure 2: The RAD7 Chart Recorder Button Bar differs slightly from the RAD8 Chart Recorder Button Bar.

  The Start RAD7 Test button begins a RAD7 test and initiates real time data tracking. This button
has the same effect as selecting Test Start on the actual RAD7. Likewise, the Stop RAD7 Test
button emulates the RAD7's Test Stop function.

The Test, Data, and Setup menus provide access to the set of commands available on
corresponding menus on the RAD7 itself. Selecting one of these commands will have the same
result as entering the equivalent command on the physical RAD7. These commands are described
in Chapter 2 of the RAD7 User's Manual. Note that menu commands ending with ellipses (...),
such as "Units..." and "Clock..." will present dialog boxes for specifying command parameters, as
shown in the Figures 3 and 4, below.

The Refresh Status Display button will update the statistics shown in the Chart Status Display, and
will cause the Chart Recorder image to be refreshed. Normally this occurs automatically at regular
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intervals, but the Refresh Status Display button is useful when an immediate status update is
desired.

The Chart Configuration menu contains two commands: Logging Settings and Chart Parameters.

The Logging Settings command is used to configure the program to log Chart Recorder data to
disk as it arrives. This is explained in the Logging Chart Data section, below.

The Chart Parameters command brings up the Chart Parameters Window, which is used to
specify the Radon Measurement Method, which may be either Radon in Air, RAD AQUA, or Water
Probe. If the RAD AQUA or Water Probe is selected, the Chart Recorder will be able to display
radon-in-water data. Computing radon-in-water concentrations requires information about the
water's temperature and salinity. The temperature can be set to either the air temperature as
recorded by the RAD8 or RAD7 (plus or minus a fixed offset), or to a fixed temperature value,
expressed in either Fahrenheit or Celsius. The salinity is expressed in parts per thousand (‰) The
Chart Parameters Window is shown in Figure 5, below.

 

Figure 3: The Chart Recorder Units Setup dialog.

 

Figure 4: The Chart Recorder Clock Setup dialog.

 

Figure 5: The Chart Parameters Window.

Chart Status Display The Chart Status Display is a panel that provides real-time statistics on the state of the selected
RAD8 or RAD7. In the case of the RAD7, the Chart Status Display includes the run and cycle
numbers of the current RAD7 reading, the date and time of the next reading, and the counts that
have accumulated in each window since the current test cycle began. Also included is the current
air temperature, relative humidity, pump current, and battery voltage of the RAD7, and the device's
internal clock settings and firmware information. The Chart Status Display for the RAD8 includes
comparable information.



The Chart Status Display is automatically updated every five minutes, notwithstanding any
immediate updates that occur when the Refresh Status Display button is clicked. Each time a
status update is initiated for a RAD7, it takes at least 5 seconds for the latest status information to
be transferred, but if a test cycle had just completed the process will take longer, because the
latest cycle data will be obtained. RAD8 status updates do not take as long, due to the RAD8's
faster data transfer speed. RAD7 status updates are timed such that the instrument is able to
produce end-of-cycle printouts without being interrupted. Once the printing is finished, Capture will
obtain a status update that includes the latest test data from the instrument.

Note that as the number of cycles in a test increases, more data has to be transferred at the end of
each cycle, and the transfer time increases. This can become a problem if the Cycle Time is very
short (e.g. 5 minutes) and there are a lot of cycles in a test, because a RAD7 will spend most of its
time transferring data, as opposed to detecting radon. Therefore it is recommended that the Cycle
Time be set to at least 10 minutes when using the Chart Recorder to monitor lengthly tests
containing many dozens of cycles. The same issues applies when monitoring the status of a
RAD8, but to a lesser degree.

Figure 6: The RAD7 Chart Recorder Status Display. Equivilant information appears on the RAD8 Chart Recorder Status Display.

Chart Recorder
Controls  

To the left of the Chart Recorder is a panel of controls, many of which are similar to the controls in
the Graph Window. The use of each control is explained below:

Open As Graph Button

Click the Open as Graph button to view the content of the Chart Recorder in a Graph Window.
This makes it possible to examine the data in more detail, apply corrections, and export it in a
variety of formats.

Concentration Units Pop-Up Menu

Determines the unit of measurement used to denote radon concentrations on the chart. The
available options include Automatic, Bq/L, Bq/m3, dpm/L, and pCi/L. For the RAD7, the Automatic
option causes radon concentrations to be presented in the unit to which the RAD7 itself has been
set.

Temperature Units Pop-Up Menu

Determines the unit of measurement used to denote air temperatures on the chart. The available
options include Automatic, Celsius, Fahrenheit, and Kelvin. For the RAD7, the Automatic option
causes temperatures to be presented in the unit to which the RAD7 itself has been set.

Point Style Pop-Up Menu

Determines the appearance of the data points on the chart. The options are Normal, Shapes, B&W
Shapes, and Hidden. The B&W Shapes option causes the graph to be rendered in black and
white.

Line Weight Pop-Up Menu

Determines the thickness of the chart lines, as measured in pixels. This value may range from 1 to
4, or the chart lines may be hidden. A thicker line may be easier to read, but it can make the graph
appear more cluttered than a single-pixel line.

Show Grid Lines Checkbox

Determines whether horizontal and vertical grid lines are visible on the chart. Horizontal lines
indicate concentration, temperature, and humidity levels, while vertical lines represent time
intervals.

Show Chart Legend Checkbox

Determines whether the legend is visible on the chart. The legend shows which colors represent
which elements on the chart. To the right of the Show Chart Legend Checkbox is a small control
for setting the placement of the Chart Legend. It may be positioned at any of the four corners of
the chart image.

View Range Pop-Up Menu (RAD7 Chart)

The RAD7 Chart Recorder contains a View Range Pop-Up Menu, which determines the maximum



visible time range supported by the accompanying View Range slider. For example, if the View
Range Pop-Up Menu is set to 1 Day, dragging the View Range Slider all the way to the left will
cause the Chart Recorder to display any RAD7 data that has been recorded within the past 24
hours. (Note that the right edge of the chart always represents the current time according to the
RAD7.) If the View Range Pop-Up Menu is set to Automatic, the visible range is determined by the
breadth of all the RAD7 data that has been loaded into the Chart Recorder thus far. By default the
Chart Recorder will load the most recent run of data, regardless of the duration of the run, and the
Automatic View Range setting will cause the chart to display all of this data. The full selection of
View Range options include Automatic, 3 Hours, 1 Day, 1 Week, 1 Month, and 1 Year. When the
View Range is expanded, Capture will load any additional RAD7 data runs that were recorded
within the specified time span. When the View Range is narrowed, the scope of the View Range
slider will be restricted accordingly, and data from outside the specified time range will be cropped
off the left edge of the Chart Recorder display.

The RAD8 Chart Recorder does not contain a View Range Pop-Up Menu. Instead it contains only
a View Range Slider and Hours Field, as described below.

Figure 7: The View Range Pop-Up Menu.

View Range Slider and Hours Field

The View Range slider zooms the Chart Recorder view in and out. In the case of the RAD8,
dragging the View Range slider all the way to the left causes the visible time range to expand to the
full range of the current test. In the case of the RAD7, dragging the View Range slier all the way to
the left causes the visible time range to expand to the range specified in the View Range Pop-Up
menu; if the View Range menu is set to Automatic, the Chart Recorder will display all the data that
has been obtained from the instrument thus far. When the slider is dragged all the way to the right,
only data recorded very recently will remain visible. (The minimum time range is the amount needed
to display 10 data points, and this will depend on the instrument's Cycle Time setting. For
example, if the Cycle Time is set to 30 minutes, dragging the slider all the way to the right will
cause the Chart Recorder to display any data recorded within the last 300 minutes, or 5 hours.)
The accompanying Hours Field can be used as an alternative to the slider: input the desired
number of hours and press Enter to set the chart range. The slider and the Chart Recorder display
will be updated accordingly.

Radon, Air Temperature, and Relative Humidity Checkboxes

These checkboxes determine whether radon, relative humidity, and air temperature points are
visible on the chart. The radon concentration data that is plotted on the chart is always taken
directly from the RAD8 or RAD7, with no corrections made with respect to humidity or other
factors.

RAD7 Printer Present Checkbox

The RAD7 Chart Recorder contains a RAD7 Printer Present checkbox, which is used to specify
whether an infrared printer is being used with the RAD7. If this box is checked, Capture will allow
printing to proceed uninterrupted after each record is recorded. If this box is not checked, updates
to the Status Display will be given higher priority, potentially interrupting end-of-cycle RAD7 printing
operations. There is no risk of such interruptions when monitoring RAD8 activity.

Monitoring Device
Groups

The Chart Recorder is particularly useful for monitoring groups of RAD8s or RAD7s. Device Groups
are user-specified sets of instruments whose data is averaged and displayed as a single chart. For
best results the timing of the devices in the group should be synchronized.

To configure a RAD8 Group or RAD7 Group, first make sure at least two RAD8s or RAD7s are
connected and their icons are visible in the Main Window Toolbar. In the toolbar, select the Options
Menu (which is labeled with a gear icon) and select Add RAD7 Group... or Add RAD8 Group...

The Group Configuration Window will appear, as shown below. This window is used to specify the
Group's name and its member devices. After the Group has been configured, it will appear as an
icon in the Toolbar, next to the other devices. A numeral on the icon will indicate how many
instruments belong to the group. Selecting a Device Group causes displays a chart representing an
average of the data belonging to the member devices.



Figure 8: The Device Group Configuration Window

Details on adding, managing, and removing RAD8 Groups and RAD7 Groups are provided in the
Toolbar Commands section.

Logging Chart Data When the Chart Recorder is active, chart data may be logged to disk in any of several formats.
Clicking the Settings button, which is accompanied by a logging indicator light to the left of the
chart, brings up the Logging Settings Window, which is shown below.

The Logging Settings Window contains checkboxes for specifying whether to log Chart Recorder
data to a radon data file, a column-based text file, and/or Capture Cloud. When logging to a radon
data file or a column-based text file, it is necessary to specify a location for the file on disk. When
logging to Capture Cloud, it is necessary to specify a name for the data set that will be stored in
the Cloud. Specifying a description is optional, but recommended.

The Logging Frequency pop-up menu is used to control how often the data is logged. The default
setting of Automatic causes data to be logged whenever the RAD8 or RAD7 records a new cycle.

After specifying the desired settings, click the Start Logging button. The Logging light on the Chart
Recorder will turn green to indicate that logging is active. Logged data will be updated whenever
the RAD8 or RAD7 records a new data point. It is possible to return to the Logging Settings dialog
at any time by clicking the Settings button. If logging is active, it may be disabled with the Stop
Logging button, found at the lower left corner of the Logging Settings dialog.

Note that even if logging is not specifically enabled, Capture will maintain records of raw Chart
Recorder data in a user library folder. These files can be revealed at any time by selecting Show
Chart Recorder Logs from the File Menu.

 



Figure 9: The Chart Recorder Logging Settings Window.

Chart Recorder
Spectrum

When the Chart Recorder is visible, it is possible to display the Chart Recorder Spectrum Window,
which contains a diagnostic histogram representing the current spectrum for the selected RAD8 or
RAD7. This histogram consists of 200 columns, each representing the number of counts that have
accumulated within a corresponding 0.05MeV (50keV) spectrum channel. If the selected device is
a RAD7 using RADLINK software version 0300 or newer, the spectrum data will comprise the
current run, or most recently completed run. If a RAD7 uses an earlier version of RADLINK, such
as version 0252, the spectrum will represent only the current cycle, and the spectrum will only
appear if the RAD7 is Live. If the selected device is a RAD8, the Chart Recorder Spectrum Window
will display the cumulative spectrum for the current test.

To display the Spectrum Window, choose Show Chart Recorder Spectrum Window from the
Window menu in the menu bar. The spectrum histogram image is automatically refreshed upon the
completion of each RAD8 or RAD7 cycle.

Figure 10: The Chart Recorder Spectrum Window.

The spectrum data content can be exported to either a text file or the clipboard. To do this click the
Export Spectrum Data button, found at the top of the Chart Recorder Spectrum Window. Exported
RAD7 data consists of 200 channel readings, one for each bar in the Cumulative Spectrum
histogram. Exported RAD8 data may consist of either 200 channel readings, or 800 channel
readings, depending on the deisred channel count. Each row of exported data represents a
different channel, and it may contain up to five columns, as follows:

Channel: The channel number, ranging from 1 to 200.
Start MeV (Inclusive): The lower inclusive bound of the channel's energy range.
End MeV (Exclusive): The upper exclusive bound of the channel's energy range.
Window: The general category of the channel, for example, "218Po (A)", "216Po (B)", etc.
Counts: The number of counts recorded in the current channel.

These fields may be delimited by tab or comma characters. If the tab character is chosen,
exported data files will use the .tsv file name extension, indicating Tab Separated Values. If the
comma character is chosen, exported files will use the .csv extension, indicating Comma
Separated Values. Either of these options allow the spectrum data to be opened in a spreadsheet
or other tool for further analysis.



Figure 11: The Export Spectrum Data Window.



  ISSUING DEVICE COMMANDS

  Any RAD7 that has had RADLINK installed may be controlled by a computer. The computer may
be connected to the RAD7 directly, or it may be connected via a network. RAD7 commands allow
for much more than the simple downloading of data; it is also possible to start and stop a RAD7,
obtain data summaries, configure the RAD7's numerous settings, and obtain the RAD7's device
details such as serial number and calibration date. In fact, any command available on the RAD7's
physical keypad may be issued from within Capture, whether the machine is located across the
room or across the continent.

Commands may also be issued to the RAD8, however this functionality is currently limited, and the
command syntax is not documented. This may change when future RAD8 firmware updates are
released.

Setting Up The easiest way to issue RAD7 commands, albeit the most restrictive, involves connecting the
computer directly to the RAD7 by means of a serial cable, and, if necessary, a serial to USB
adaptor. This configuration is identical to that used when downloading RAD7 data, and it is
described in in the Obtaining RAD8 and RAD7 Data section.

Issuing commands from a more distant location can be achieved through the use of networks. It is
not practical to describe every one of the myriad possible network configurations, but typical
connection scenarios are explained in the Network and Remote Connectivity section. It is
recommended however that users first learn how to issue RAD7 commands via a direct serial
connection, before moving on to more advanced operations involving networked devices.

Issuing Commands After connecting to a RAD7, select its icon in the Main Window Toolbar and select Issue RAD7
Command from the Main Window's Category panel.

Next, choose one of the preset commands from the RAD7 Commands Combo Box. You may also
enter RAD7 commands not present in the list of presets by typing them manually. A complete list
of RAD7 commands is available in Chapter 2 of the RAD7 User's Manual. After a command has
been selected or entered, click the Issue button to send the command to the RAD7.

The sent command will appear in the RAD7 Output text area, followed by any response. In the
screen shown below, the user has issued the Special Status command, and the RAD7 has
responded with details on its current condition.

For another typical example, suppose you wanted to obtain the information that the RAD7 normally
sends to its wireless infrared printer. To achieve this, choose "Setup Format Long" from the RAD7
Commands menu and click Issue. Then to initiate the data transfer select "Special SprAll" and click
Issue again. (Using the "Long" format ensures that all available details will be included in the
transmission.)

Additional commands may be issued at any time, and the contents of the RAD7 Output text area
may be copied to any text editor for archival or printing. Alternatively, the text may be saved to a file
by choosing "Export RAD7 Output" from the File menu.



Figure 1: Issuing commands to a RAD7 connected via a serial port



  DRYSTIK CONNECTIVITY

  Capture can connect not only to the RAD8 and RAD7, but also to the Durridge DRYSTIK active
moisture exchanger. Compatible DRYSTIK models include the ADS-3 and ADS-3R. Each connects
to the computer via USB, with no serial adaptor required. Driver software is required in order for
Capture to communicate with the DRYSTIK; it is the same driver used to connect a RAD8 and
most RAD7s. If necessary this driver can be downloaded from the Durridge website. Be sure to
install the appropriate version of the driver based on your operating system.

Setting up the
DRYSTIK

Once the appropriate driver has been installed, connect the DRYSTIK to the computer as shown in
Figure 1, below. The DRYSTIK model ADS-3 uses a USB-A to USB-B cable, while the DRYSTIK
ADS-3R requires a USB-A to USB Mini-B cable. Next connect the DRYSTIK's power supply and
power the unit On. Finally, launch Capture. As the program starts up it will automatically detect any
connected DRYSTIK(s). An icon representing each DRYSTIK will appear in the Main Window
Toolbar, alongside any connected RAD8s and RAD7s. As with other devices, DRYSTIKs can be
manually added, and renamed, disconnected, and reconnected using the toolbar menu
commands. Note that DRYSTIKs always communicate with the computer at 9600 baud, so there
is never any need to specify the connection speed when manually connecting to a DRYSTIK.

Figure 1: Setting up the DRYSTIK ADS-3 and ADS-3R for use with Capture.

12uOUT
-++

120IN

POWERON

POWEROFF

BELT&4-2BB66コT

DRYSTIKModelADS-3

USB-BCable

MiniUSB-BCable

ComputerwithFTDI
VirtualCOMPortDriver
andCAPTURESoftware

專吣

12VDCIN

SAMPLE
IHLET

LUSE
[POWERONI

POWEROFFI

12WOUT
1.0H

[DECOUTPUTI

INTERNAL
PUMP

PUMP
OUT

IHHER
TUBING

DRYSTIK'ADS-3R

EXHAUST
OUT

DUBRIDGE
DRUSTIR

CorP
ADS-3

DURRIDGE

DRYSTIKModelADS-3R

THISH
AIRFLOW

LOW
AIRFLOW

ADJUST.
AIRFLOW

FLOW
ADJUST

FLFGEIH

FROMRHOT



Monitoring the
DRYSTIK Status

When a DRYSTIK is connected to the computer and its icon is selected in Capture's Main Window
toolbar, the device's status will be displayed as shown in Figure 2, below. The status display
consists of a black panel containing a set of green lights, which emulates the DRYSTIK's faceplate
LEDs, indicating the device's power, pump, and alert state. Clicking the circular Refresh Arrows to
the right of these status indicators updates the device status. The Refresh Arrows spin whenever
communication is occurring between the computer and the DRYSTIK.

Below the device status panel are several rows of text indicating the DRYSTIK's current state.
These include the device's Pump Current, the time remaining in the current Period, the current
Duty Cycle, the DRYSTIK's model and serial numbers, and more.

Figure 2: The DRYSTIK monitoring interface in Capture.

Controlling the
DRYSTIK

Below the Current DRYSTIK Status panel are several controls for modifying the device's behavior.
(Actually running the DRYSTIK requires selecting a profile, as explained in the Configuring DRYSTIK
profiles section, below.)

Resume Using Last Profile At Startup Checkbox
This checkbox controls whether the DRYSTIK will automatically select the most recently used
profile and become active after being powered on.

LCD Backlight Pop-Up Menu
This pop-up menu has two options: "Always On" and "Turns Off After...". If the second option is
selected, a field will appear which will allow a duration value to be specified. The DRYSTIK's LCD
screen backlight will then remain lit for the specified number of seconds during periods of inactivity.
Whenever a button is pressed on the DRYSTIK's faceplate the backlight will turn back on, and the
display will remain illuminated for the duration specified.

Pause/Unpause Button
The Pause button pauses the DRYSTIK, deactivating its pump if it is running, without canceling out
of the current profile or resetting the current period. Clicking this button again unpauses the



DRYSTIK, resuming from where it left off.

Stop Button
The Stop button cancels out of the current profile, disabling the pump if necessary. Once the
DRYSTIK has stopped, its period is reset and its state is set to Idle.

Reboot Button
The Reboot button cancels any DRYSTIK activity and restarts the device. After the DRYSTIK has
rebooted, it will resume from the last profile used if it has been configured to do so.

Update Firmware Button
The Update Firmware button becomes enabled if the DRYSTIK is found to be using an outdated
version of its firmware. Clicking this button initiates a firmware updating procedure, which takes
less than a minute. Do not power off the DRYSTIK or the computer while the update in is progress.
When it is finished updating, the DRYSTIK will reboot.

Configuring DRYSTIK
Profiles

The right side of the DRYSTIK interface contains controls for configuring and running DRYSTIK
profiles, as shown in Figure 3. The DRYSTIK Profiles list includes the names of each Built In Profile
and User Profile stored in the DRYSTIK, plus a "Manual Mode Profile" which is used when custom
settings are needed. To run a profile, select its name in the list and click the Run Profile button to
the right. (Profiles can also be selected and run using the physical buttons on the DRYSTIK itself.)

 

Figure 3: The interface for configuring DRYSTIK profiles in Capture.

  To edit a DRYSTIK profile, select its name and click the Edit Profile button. This enables controls
used to specify the profile's Name, Period, Duty Cycle, and more. Note that only User Profiles and
the Manual Mode profile may be edited; the Built In profiles come preconfigured and can not be
modified. Once a profile has been edited, click the Save Profile button to confirm any changes. The
Run Profile button will then become enabled, allowing the DRYSTIK to operate using the selected
profile. Each profile property control is explained below:

Profile Name Field
The Profile Name field contains the name of the selected profile as it will appear in Capture and on
the DRYSTIK's LCD screen. Profile names are limited to 16 characters in length.

Period Field
The Period field contains the number of minutes in the profile's period. The Period is the length of
time the DRYSTIK's pump takes to finish one complete on/off cycle. When a cycle begins the
pump turns on, and it remains running until a particular portion of the Period has elapsed, after
which it remains off for the remainder of the Period. Once the full Period has completed, it repeats,
with the pump turning back on to begin the next cycle.

Duty Cycle Field
The Duty Cycle field contains a percentage value representing the portion of the Period in which
the DRYSTIK's pump remains on. For example, if the Period is 5 minutes and the Duty Cycle is set
to 20%, then the pump will run for one minute out of every five.

Solenoid Enabled Checkbox
The Solenoid Enabled checkbox is used to specify whether the DRYSTIK's solenoid will be on
when the selected profile is in use. When the solenoid is on, it pulls a High Airflow stream into a
path that is otherwise occupied by Low Flow or Adjustable Flow air. Note that the solenoid can
only be on when the pump is active. The solenoid is an optional component, and this checkbox will
only be enabled if the solenoid is present on the device.



Next Profile Pop-Up Menu
The Next Profile pop-up menu is used to specify which profile will run after the selected profile has
been active for a particular amount of time. It is used in conjunction with the Delay Until Next Profile
field. If the selected profile should run indefinitely, select None from this pop-up menu.

Delay Until Next Profile Field
The Delay Until Next Profile field indicates the number of minutes that the selected profile will
remain running before the next profile begins. If the Next Profile pop-up menu is set to None, the
Delay Until Next Profile field is disabled.

To make the solenoid turn on and off at regular intervals, configure two profiles, one of which
enables the solenoid. Each profile's "Next Profile" should be set to that of the other. The intervals at
which the solenoid turns on and off can be controlled by specifying the desired Period and Delay
Until Next values for each profile. Since the solenoid can only be on when the pump is active, it is
advised that the Duty Cycle be set to 100% for any profile involving an active solenoid.



  CAPTURE CLOUD

  Capture Cloud is a service for storing, organizing, and sharing RAD8 and RAD7 data from any
computer running Capture. Shared data can be made accessible to any authorized Capture Cloud
user. Additionally, Capture Cloud subscribers are granted access to premium Capture software
features which are otherwise disabled.

Capture Cloud Feature Summary

When signed in to Capture Cloud, RAD8 and RAD7 data can be saved to a Capture Cloud server
hosted by Durridge, and then later retrieved, modified, and saved back to the Capture Cloud
server. A Data Browser lets you explore collections of RAD8 and RAD7 record sets, and issue
search queries to find data from a particular organization, instrument, date range, plus additional
criteria. Radon data can be assigned custom searchable tags to associate it with a particular
project, job site, technician or other attributes. When a radon data set is selected from the list of
search results, it can be viewed and edited using Capture's Graph Window. Radon data that has
been uploaded to Capture Cloud becomes available to Capture Cloud users who belong to the
organization that owns the device from which the data came. Additionally, data can be shared with
select users from outside one's organization. Note that Capture Cloud is a premium feature which
requires a Capture Pro license.

Setting Up a User
Account 

To sign up for Capture Cloud, first purchase Capture Pro at
https://durridge.com/software/capture/. Then register your Capture Cloud account using the form
at https://durridge.com/software/capture-cloud/. Note that an unlimited number of Capture
Cloud user accounts can be added at no additional charge.

After you complete the registration form a Durridge administrator will process your submission, and
you will receive an email containing the sign-in credentials needed for you and other users in your
organization to log in to your new Capture Cloud account. Once logged in, you can store and
retrieve data from the Durridge devices belonging to your organization.

Updating Account Settings

If you wish to modify your Capture Cloud account by adding or remove users or devices, go to the
Capture Cloud web page at https://durridge.com/software/capture-cloud and complete the
Update Account Settings Form, which is found near the top right section of the page.

Signing in to Capture
Cloud

To sign in to your Capture Cloud account, click the Capture Cloud toolbar button at the top of the
Main Window, and then enter your email address and password, as shown in Figure 1, below.
Then click the Sign In button. Check the Remember sign-in credentials checkbox if you do not
want to have to reenter your email address and password each time you connect to Capture
Cloud. Check the Sign in automatically at launch checkbox to bypass the sign-in panel in the
future.

If you forget your password, or wish to change it, click the Reset Password link under the Sign In
button, and refer to the Password Resetting section below.

Once you have signed in, the Capture Cloud Browser will appear, allowing you to locate files that
have been uploaded from your organization's device(s). The Capture Cloud Browser is explained in
depth later in this section.



Figure 1: Signing in to Capture Cloud.

You will remain logged in to your Capture Cloud account until you quit the Capture application or
sign out of Capture Cloud. To sign out, use the Sign Out button at the bottom left corner of the
Capture Cloud Browser. You will be returned to the Capture Cloud Sign-In Panel, where you or
another user may sign back in.

Saving Data to Capture
Cloud

 

There are four situations in which radon data may be saved to Capture Cloud: when data is being
downloaded from a RAD8 or RAD7; when data is visible in a Graph Window or the Chart
Recorder; when data is being logged in the Chart Recorder; and when a data file is dragged and
dropped into the Capture Cloud Browser. Note that in each case it is necessary to be signed in to
Capture Cloud, as described above.

Saving data to Capture Cloud when downloading from a device

When data is being downloaded from a RAD8 or RAD7 to Capture, it can be saved to your local
disk and/or your Capture Cloud account. To save the data to Capture Cloud, check the Save Data
to Capture Cloud Checkbox in the Main Window's Download RAD8 (or RAD7) Data panel. As the
download begins you will be prompted to provide a name and description for the data set as
shown in Figure 2, below. It is helpful to choose a unique and memorable name and description in
order to be able to easily locate the data at a later time using the search tools in the Capture Cloud
Browser.

Figure 2: Specifying the name and description of a data file being saved to Capture Cloud.



Once the data has been fully downloaded from the device and verified, it will be saved to Capture
Cloud. Upon completion, a notification dialog will appear, confirming that the data was successfully
saved to the cloud.

Saving Graph Window or Chart Recorder data to Capture Cloud

RAD8 or RAD7 data from a Capture Graph Window or the Chart Recorder can be saved to your
Capture Cloud account. First open a Graph Window or view the Chart Recorder as necessary, by
choosing File --> Open Data File... and selecting a radon data set to graph. Then choose File -->
Save to Capture Cloud. You will be prompted to confirm the radon data set name and description,
as shown in Figure 2.

Figure 3: A confirmation message indicating that data has been successfully saved to Capture
Cloud.

Note that RAD7 data may only be uploaded to Capture Cloud if it was obtained from a RAD7
containing RADLINK. If RADLINK is present, the serial number of the RAD7 will appear in the
heading of the Graph Window's Statistics Panel.

Once the data has been uploaded, it will appear in the Search Results list in the lower left section of the Capture
Cloud Browser, as shown in Figure 5, below.

Saving data to Capture Cloud by dragging and dropping

It is also possible to save a RAD8 or RAD7 data file to Capture Cloud by dragging it from a folder on the desktop
and dropping it into the Results list in the Capture Cloud Browser. When a file is dropped into this list, you will be
prompted to specify a Name and Description, as shown in Figure 2, above.

Logging Chart Recorder data to Capture Cloud

When the Chart Recorder is monitoring the status of a RAD8 or RAD7 in real time, Capture can be configured to
continuously log the radon data to a file on disk, or to Capture Cloud. For more information please refer to the
instructions in the Logging Chart Recorder Data section.

Replacing existing Capture Cloud data

If you attempt to upload radon data but another data set from the same device with an overlapping
date range already exists on the Capture Cloud server, a message will appear asking if you would
like to replace the existing data, as shown in Figure 4, below. Replacing existing data will
irrevocably overwrite its contents. Note that when data is being logged to Capture Cloud from the
Chart Recorder, the data file on the Capture Cloud server will automatically expand as each new
data point is recorded.

Figure 4: Notification that already exists on the Capture Cloud server.

Saving combined data to Capture Cloud

It is possible to upload a combined data file containing radon data from more than one device, as
long as the user belongs to the organization(s) that own the associated devices. Once the
combined data has been saved to Capture Cloud, it will be listed in the Capture Cloud Browser
under the heading of the device with the lowest of the various serial numbers represented in the
combined data. For example, if a radon data file contains data from RAD7s 5000, 5001, and 5002,
it will appear in the Browser as if it belongs to RAD7 5000. (For more information on combining
data files, see the Combine Radon Data Files section.)

Browsing Capture
Cloud Data

The Capture Cloud Browser provides access to all of the radon data files that you and the other
members of your organization have saved to your Capture Cloud account. It also provides access
to any data files that have been specifically shared with you. The browser is shown in Figure 5,



below.

Whenever you are signed in to Capture Cloud, the browser will remain accessible via the toolbar in
Capture's Main Window. The browser consists of controls for specifying optional search
parameters, a Results List Box containing search results, and a Preview panel showing a graph of
the selected result, plus additional details. Buttons at the bottom of the window are used for
sharing the selected data set with other users, saving the selected data set to a local disk, and and
opening it in a new Graph Window, respectively.

The controls for searching for Capture Cloud data occupy the top left section of the browser panel.
These controls can be used to specify several search parameters, including File Types,
Organization, Device, Date Range, Name, Description, and Data Tags. If no search criteria are
specified, the Results List Box will contain every known data file from the organization(s) and
device(s) associated with your Capture Cloud account. This list has the potential to grow quite
long, so it may occupy multiple pages, each of which may contain between 25 and 200 items. But
the list can be quickly narrowed down to a manageable length by specifying specific search
parameters.

Searching with Data Tags

Data Tags are custom labels that can be assigned to files to designate them as belonging to a
particular category, in order to improve searchability. One or more data tags may be included as
search parameters using the blue Plus button (＋). A data tag can be removed from a search
query by clicking its (✕✕✕✕) button. The orange And / Or control is used to specify whether the results
must contain all of the specified data tags, versus any of the specified data tags.

Search results can be sorted by Name, Description, Organization, Device, or Ending Date, either in
ascending or descending order, by clicking the desired column heading at the top of the Results
List Box. Double-clicking on an item in the Results List Box will open the data in a new Graph
Window.

Figure 5: The Capture Cloud Browser.

Creating Search Presets

Specific combinations of search parameters can be saved as Search Presets for later reuse. To
create a Search Preset, first enter the desired search criteria in the Capture Cloud Browser; this
may include an Owner, Organization, Device, Date Range, Name, Description, and/or specific Data



Tags. Next go to the Search Preset pop-up menu near the top left corner of the Capture Cloud
Browser, and choose "Add Search Preset..." You will be prompted to enter a name for the new
Search Preset, as shown in Figure 6, below. After clicking OK, the new preset will be included in
the Search Preset pop-up menu. This search preset will remain available unless or until it is
deleted.

Figure 6: The Add Search Preset Dialog

Managing Search Presets

To rename or delete an existing Search Preset, go to the Search Presets pop-up menu near the
top left corner of the Capture Cloud Browser, and choose "Manage Search Presets..." The Manage
Search Presets Window will appear as shown in Figure 7, below. Select a Search Preset from the
list at the left side of the window to view the specific search criteria contained in the preset, and
enter a new name or click the Delete Search Preset button, as desired. Note that two separate
Search Presets may not share the same name. When finished, click OK to return to the Capture
Cloud Browser. The contents of the Search Presets menu will reflect any changes that have been
made.

Figure 7: The Manage Search Presets Window

Names, Descriptions,
and Data Tags

When a radon data set is selected from the list of search results, its details appear in the panel on
the right side of the window. These details include three editable properties: Name, Description,
and Data Tags. To edit one of these attributes, click the corresponding Edit button, which is found
near the right edge of the Capture Cloud Browser, as shown in Figure 5, above.

When finished editing a Name or Description, press the Enter key or click the accompanying
checkmark button (✔) to the right of the text field. To cancel the editing of a Name or Description,
click the accompanying (✕✕✕✕) button.

When Data Tags are being edited, they will appear in purple, as shown in the Figure 5, above. To
add a Data Tag to a file, click the Plus button (＋). To remove a data tag, click its (✕✕✕✕) icon. Once
tags have been assigned, they can be used as search parameters to more easily find the radon
data set in the future.

Sharing Capture Cloud
Data

Once RAD8 or RAD7 data has been uploaded to Capture Cloud, it will be accessible to the user
who uploaded it, and to all other members of the organization that owns the device that produced
the data. Data can also be made available to Capture Cloud users from outside that organization.



To share a data file with an outside user, select an item in the Capture Cloud Browser and click the
Share Data File... button, which is located at the bottom of the window, under the graph display.
The Share Data File Window will appear, as shown in Figure 8, below.

Figure 8: The Share Data File Window.

To share the selected data file with a Capture Cloud user from another organization, enter their
email address in the Add User field at the top of the Share Data File Window, and click Add User.
Their name and email address will appear in the Current Users list. To revoke a user's ability to
access the data file, select a user in the list and click the Remove Selected User button. When
finished, click the Done button.

Once a user has been given access to a shared data file, it will appear in their Capture Cloud
Browser. The user will be able to view the file in a Graph Window, but they will not be permitted to
save any changes to the file back to Capture Cloud.

Password Resetting If you forget your Capture Cloud password, or wish to change it, go to the Capture Cloud panel in
the Main Window, and click the Reset Password link under the Sign In button. You will be
prompted to enter the email address of your Capture Cloud user account, as shown in Figure 9,
below. After entering your email address, click Continue. You will receive an email from "no-
reply@durridge.com" containing a password reset code. If this email is not immediately visible,
check your Junk or Spam folder.

Figure 9: The Reset Capture Cloud Password Window.

Capture will prompt you for the password reset code as shown in Figure 10, below. This code can
be copied and pasted from the email that you received. You will also be asked to specify your
desired new password. The new password should be long and/or complex in order to satisfy
security requirements, and it must be entered twice for verification purposes. After you have
pasted your password reset code into the Password Reset Field, and entered and verified your
new password, click Continue.



Figure 10: Entering a Password Reset Code and a new password.

Once the password has been reset, a notification will appear as shown in Figure 11, below. Click
Finish to return to the Main Window, where you will be able to sign in to Capture Cloud using your
new password.

Figure 11: Notification of successful Capture Cloud password reset.



  EVENT-DRIVEN ACTIONS

  Capture can be configured to perform specified sequences of actions when particular sets of
conditions are met. For example if a RAD7 reports a radon concentration that is greater than a
certain value, Capture can respond by playing an alarm sound and/or sending an email notifying
the user. There are 11 categories of conditions that may be evaluated, and 13 types of actions that
may be performed in response, allowing a wide variety of custom configurable behaviors. A
particular combination of conditions and associated responses is called an Event-Driven Action.
The toolbar in Capture's Main Window provides access to the Event-Driven Actions panel, which is
used to create and configure Event-Driven Actions, as shown in Figure 1, below.

The use of Event-Driven Actions requires a Capture Pro license. If you have not purchased a
Capture Pro license it is still possible to create and configure Event-Driven Actions, but they will not
be able to be executed.

Note that Event-Driven Actions are currently limited to the RAD7. A future Capture update will
expand Event-Driven Actions to include RAD8 support.

Managing Event-
Driven Actions

To create an Event-Driven Action, click the Plus button [+] near the bottom left corner of the Event-
Driven Actions panel. A new untitled Event-Driven Action will be added to the list on the left side of
the window. To delete an Event-Driven Action, select it in the list and click the Minus button [-],
which is next to the Plus button. The configuration of the Event-Driven Actions will be saved when
Capture is closed, so they will be available for use in future sessions.

When an Event-Driven Action is selected in the list, its properties appear in the tab panel to the
right. There are three categories of Event-Driven Action properties that can be edited, and these
are found within tabs labeled General, Events, and Actions.

To enable or disable Event-Driven Action functionality, use the main switch control at the top right
corner of the window. If this switch is turned Off, Event-Driven Actions can still be configured, but
they will not be executed, even if the specified conditions have been met. It can be useful to turn
Event-Driven Actions off before editing them, and then turn them back on once editing is complete.
This prevents Event-Driven Actions from being triggered prematurely, before they have been fully
configured. Note that if you do not have a Capture Pro license, it will not be possible to turn on the
main switch.

Configuring General
Properties

The General tab is used to configure the basic properties of the selected Event-Driven Action, as
shown in Figure 1, below. These include its name, whether it is enabled, whether it is triggered
when any versus all of the specified events are occurring, how often actions should be executed
when the specified events are occurring, and whether the timing of the Event-Driven Action is reset
when the required events are no longer occurring.



Figure 1: The General tab in the Event-Driven Actions panel.

Setting Up Events

 

The Events tab, which is shown in Figure 2, is used to specify which events must occur in order for
the selected Event-Driven Action to be executed. Any number of events may be attached to an
Event-Driven Action. To add an Event to the selected Event-Driven Action, click the Plus [+] button
at the bottom of the Events list. To remove an Event, select it in the list and click the Minus [-]
button.

The definition of each Event includes a device, a device property, a comparison type, and a value
to which the property is compared.

The Device may be set to either Any RAD7, or a Specific RAD7. If Specific RAD7 is chosen, its
serial number must be provided.

The possible device properties that may be evaluated include a RAD7's Battery voltage,
Connection status, Counts per minute, Cycle number, Data Free value, Pump current, Radon
concentration, Relative humidity, Run number, Temperature, and Thoron concentration.

Each of these properties are compared to a specified value using one of the following comparison
criteria: greater than, less than, equal to, not equal to, greater than or equal to, and less than or
equal to.

When the device, device property, comparison type, and comparison value have been specified,
the description of the Event is updated in the Events list accordingly.

If any (or all) of the specified events are found to be occurring, one or more Actions will be
performed in response.



Figure 2: The Events tab in the Event-Driven Actions panel.

Setting Up Actions The Actions tab, which is shown below in Figure 3, is used to specify which actions occur when
the necessary conditions have been met and the selected Event-Driven Action is executed. Any
number of actions may be attached to an Event-Driven Action. To add an Action to the selected
Event-Driven Action, click the Plus [+] button at the bottom of the Actions list. To remove an Action,
select it in the list and click the Minus [-] button.

The following categories of actions are supported: Add message to Capture Log, Advance RAD7
to next run, Erase RAD7, Issue RAD7 command, Play alarm sound, Save RAD7 data to Capture
Cloud, Save RAD7 data to disk, Send email, Set RAD7 relays, Start RAD7, Stop RAD7, Start
DRYSTIK, and Stop DRYSTIK.

Each action has a set of parameters that must be configured. For example when configuring the
"Save RAD7 data to Capture Cloud" action, it is necessary to specify which RAD7's data will be
saved, whether to save all of the RAD7's data or just the latest run, whether to include the RAD7
serial number and date in the file name, and more.

When an Event-Driven Action is executed, its actions will be executed one at a time, in the order in
which they were added to the Actions list.



Figure 3: The Actions tab in the Event-Driven Actions panel.



  NETWORK AND REMOTE CONNECTIVITY

  When a Durridge instrument is operating in a dangerous or inaccessible location, or any location
more than a few feet away from a computer, it may be desirable to connect to it remotely.
Depending on the situation, this may be achieved via a Wi-Fi connection, a wired a local area
network connection, an internet connection, or Bluetooth. This section explains how to configure
Capture for these types of connections. The RAD8, RAD7, and DRYSTIK can be accessed over a
network, and the RAD7 can additionally be accessed over Bluetooth, using an optional adaptor
accessory.

Once Capture has established a connection with a remote instrument, standard operations such
as downloading data and device monitoring can proceed as they would normally. Each remote
communication method is described below.

RAD8 Wi-Fi
Connections 

The RAD8's built-in Wi-Fi allows it to connect to a computer running Capture on a wireless local
network. First, go to the RAD8's System Settings menu and choose Wi-Fi. Make sure the RAD8 is
connected to the local network, and take note of the RAD8's local IP address. This address is
displayed on the Wi-Fi Screen, and on the About Screen, which is accessible from the Main Menu.

Wi-Fi is the recommended approach for connecting to a RAD8, as it allows the RAD8 to be further
from the computer, and it offers much faster data transfer speeds than a USB connection.

Figure 1: Using Capture software to connect to a RAD8 over a wireless local area network.

Next launch Capture on the computer, and click the Add Device button on the Main Window
Toolbar. Choose Add RAD8, and set the Connection Type to Network, as snown in Figure 2,
below. In the accompanying IP Address field, enter the address stated on the RAD8 screen. The
Interface menu should be set to RAD8 Built-In Wi-Fi. Click the Connect button. Once connected to
the RAD8, Capture will allow you to Download RAD8 data and monitor and control the instrument
via the Chart Recorder.

Figure 2: Connecting to a RAD8 over a wireless local network, using the instrument's built-in Wi-Fi.

RAD8 Wired Network
Connections

The RAD8 does not contain a built-in ethernet port for wired network connections, however it is
possible to connect a RAD8 to a wired local area network through the use of an optional access
point accessory. This is in effect a mini wireless router that is physically connected to the wired
network, and communicates with the RAD8 wirelessly. For more information, plese see the RAD8
Wired Network Connection article on the Durridge website.

Server-Assisted
Connections

Capture can communicate with RAD8s, RAD7s, and DRYSTIKs that have been connected to a
server on a local area network. The "server" may be another computer running Capture, or in the
case of the RAD7 it may be a serial-to-ethernet device server such as a Lantronix xDirect, or a
serial-to-Wi-Fi device gateway such as the Lantronix SGX 5150. In either case the server to which



the Durridge instrument is connected receives commands sent from a computer running Capture,
and then immediately relays those commands to the instrument. When the instrument issues a
response, the server relays the response back to Capture.

Note: most of the information below about the Lantronix xDirect also applies to the Lantronix SGX
5150, however the SGX 5150 uses a different kind of cable to connect to the RAD7, and it does
not need to be directly plugged into a router.

Network-based connections are easier to set up if all of the required equipment exists within the
same local area network, and there is no security equipment impeding communication between
devices. Communicating with a RAD8, RAD7, or DRYSTIK across the internet is slightly more
complicated; this is discussed in the Internet Communications section below.

Figures 3 and 4, below, show how to connect RAD8s and RAD7s to networking hardware. Figure
3 shows a RAD8 and RAD7 connecting via a relaying computer. Figure 4 shows a connection
involving RAD7s with Lantronix xDirect devices. Note that a relaying computer can facilitate RAD8,
RAD7, and DRYSTIK connections, whereas a Lantronix xDirect can facilitate only RAD7
connections. Multiple Durridge instruments can be connected to a single relaying computer, as
shown in Figure 3, whereas only one RAD7 can be connected to each Lantronix xDirect device.

Figure 3: Communicating with RAD8s and RAD7s over a wireless local area network using a relaying computer (aka server) to send data between the instruments and
a client computer.



Figure 4: Communicating with RAD7s over a wireless local area network using Lantronix xDirect Serial to Ethernet Device Servers.

To establish a connection to a RAD8, RAD7, or DRYSTIK on a local network, first launch Capture
on the client computer (which is the computer to which the Durridge instrument is not directly
attached).

If the server is a relaying computer, launch Capture on the server as well, and in the Main Window
enter the Relay RAD8 Commands, Relay RAD7 Commands, or Relay DRYSTIK Commands panel,
as shown in Figure 5. Click the Listen button to prepare to receive commands from the client. This
will allow any commands received by the server to be passed on to the RAD8, RAD7, or DRYSTIK.
When Capture begins listening for incoming commands, the Listen button will change to Stop.



Figure 5: Relaying RAD7 commands using Capture operating as a server.

If the server is a Lantronix device, no configuration is required for it to operate on a local area
network, but it is nevertheless advisable to review the instructions provided by the device
manufacturer to establish familiarity with the product.

On the client computer, go to Capture's Main Window and click the green Add Device button, and
then select either Add RAD8, Add RAD7, or Add DRYSTIK from the menu. The Connection Panel
will appear as shown in Figures 6 and 7, below.

In the IP Address field, enter the local IP address of the server to which the Durridge instrument is
directly connected. (This number is typically similar to the local IP address of the client computer,
however the last few digits will differ.) The Port Selection menu should be set to Automatic if the
server to which the instrument is connected is another computer running Capture. The Port
Selection menu should be set to Manual if the server is a Lantronix device or similar. In the first
case, enter the Serial Number of the RAD8, RAD7, or DRYSTIK. In the second case, enter the
server's communication port number. If a Lantronix xDirect is being used, the port number is
10001 by default. Please refer to the manufacturer's documentation to determine the correct port
number as necessary.

Figure 6: Connecting to a RAD8 over a network using a Capture Relay interface; the RAD8's serial number must be provided. This connection option is used
when Capture is operating as a server, facilitating the transfer of commands and responses to another computer running Capture.



Figure 7: Connecting to a RAD7 over a network using a user-specified port number. This connection option is used when the server is a Lantronix xDirect
device or similar.

After the server starts listening for incoming commands, click Connect on the client computer.
Once the connection becomes active, operations may be performed in the same manner as if
there was a direct serial connection between the client computer and the server to which the
Durridge instrument is attached. To end a session, either click the Disconnect button on the client
copy of Capture, or (if applicable) click Stop on the server copy of Capture to prevent it from
relaying commands.

Internet
Communications 

Communicating with a Durridge instrument across the internet is similar to communicating over a
local area network. The main difference is that the router at the location of the instrument must be
configured to forward a specific port to the local IP address of the server. (If the server is a
Lantronix xDirect, the port number will typically be 10001.) Please consult your router manual for
details on how to configure port forwarding.

Once port forwarding has been set up, open Capture on the client computer, and in the Network
connection panel (shown in Figure 7) enter the external (public) IPv4 address of the instrument's
location in the IP Address field. (To determine a location's external IPv4 address, visit
https://whatismyipaddress.com.) The Port Selection menu should be set to Manual, and the Port
Number field should be set to the port number used by the server (10001 in the case of the
Lantronix xDirect). Please refer to the Lantronix documentation to determine the correct port
number as necessary.

Note that if multiple RAD7s are connected to a router via multiple Lantronix xDirect devices, each
Lantronix device must be configured to use a different port, and the router's port forwarding should
be configured accordingly.

Figure 8: Communicating with RAD7s over the internet using Lantronix xDirect Serial to Ethernet Device Servers and a router configured with port forwarding.

Remote Desktop
Software 

If port forwarding is not an option and a computer is available at the location of the RAD8, RAD7,
or DRYSTIK, a long-distance connection can be achieved using remote desktop software such as
TeamViewer. With this software one computer can be controlled by another over the Internet. The



user can assume control over a remote computer running Capture that is directly attached to the
Durridge instrument.

It is also possible to control one computer from another on the same local area network. On a
computer running macOS, go to the Sharing panel in System Preferences, and enable Screen
Sharing. On a Windows 10 computer, go to System panel in Settings, and choose Remote
Desktop. For details, please consult the Apple or Microsoft documentation as necessary.

RAD7 Bluetooth
Connections

For short distance wireless connections between the RAD7 and a computer, the simplest solution
is to attach a Serial to Bluetooth adapter to the RAD7's serial port. A Serial to Bluetooth adapter
can create a virtual serial port on a nearby computer in much the same way as a serial to USB
adapter cable. Therefore connecting to a Bluetooth-enabled RAD7 is as simple as clicking the
Scan for RAD7s button in Capture's Main Window.

Durridge offers the Parani SD1000 Serial to Bluetooth Adapter preconfigured for use with the
RAD7, making the connection process very straightforward. This adapter has been tested across
distances exceeding 40 meters, through walls and trees, and it is known to support 100 meter
communication along uninterrupted lines of sight, particularly if the optional Extended Range 3 dBi
Dipole Antenna is attached.

Other Bluetooth adapters may be used as well, however any adapter not supplied by Durridge
must be manually configured. This involves setting the adapter to operate at the RAD7's specific
baud rate (typically 9600 baud). The adapter must also be configured as "discoverable", and any
command response behavior must be disabled to avoid flooding the RAD7 with unwanted
feedback. The procedure for completing this configuration will vary by adapter.

Durridge provides detailed instructions on using the Parani SD1000 Serial to Bluetooth adapter
with the RAD7. Please see the RAD7 Bluetooth Connectivity guide for details.

Figure 9: A RAD7 connected using a Serial to Bluetooth adapter will automatically appear on one of the computer's serial ports.



  DATA EXPORT, REPORTS, AND PRINTING

  The File menu contains commands for exporting RAD8 and RAD7 data in various formats,
generating several different kinds of reports, and for printing data graphs. These features are
detailed in this section.

Exporting RAD7 Data After RAD8 or RAD7 data has been downloaded or opened from disk and displayed in a graph
window, it may be exported in any of several formats.

The Export Selected Data command in the File menu includes options for exporting different types
of files, as described below. Most of these will involve only the selected records, which are those
found between the two Selection Bars. More information on using the Selection Bars is available in
the Graph Window Navigation section.

Figure 1: Export Selected Data options in the File menu.

  Exporting RAD7 Data Files

The RAD7 Data File submenu command exports a R7CDT or R7RAW Data File containing only the
data that is selected on the graph. The exported file will contain only valid data, and will therefore
not produce any fatal error messages when opened for graphing. Choosing the RAD7 Data File
option will present a Save As dialog box, in which the name and location of the exported file may
be specified, as well as the file type.

Two file type options may be offered: "RAD7 Data File (With Supplemental Data)", and "RAD7 Data
File (Without Supplemental Data)". The first option produces a R7CDT file which contains not only
the radon data, but also information about the RAD7 from which the data came, as well as
information on thoron concentrations and record run numbers. The second option produces a
simpler R7RAW file, which contains only radon data. Such files adhere to the format seen when
downloading data using the RAD7's "Data Com" or "Special ComAll" commands. This format is
fully documented in the RAD7 manual, and may be preferable if the output is intended for use with
third party applications or custom tools. Note that if the original data set does not contain
information on the RAD7 from which it came, the option to include supplemental data will not be
offered and the result will be a R7RAW file. More information on the R7RAW and R7CDT file
formats is available in the File Formats section.

  Exporting Column Based Data

The Export Selected Data command produces a submenu containing two related commands:
Column Based Text File, and Column Based Text to Clipboard. These submenu commands
produce textual data in a format suitable for importing into Microsoft Excel and other spreadsheet
applications. The Column Based Text File command saves the data to a plain text file with the .csv
or .tsv file name extension (indicating "Comma Separated Values" or "Tab Separated Values"),
while the Column Based Text to Clipboard command simply copies the information to the
clipboard, making it possible to paste it into another program.

Both of these operations bring up the Export Column Based Text Window, which is shown in
Figure 2, below. This window is used for specifying the desired fields for inclusion in the exported
data. Each included field is exported as a separate column of tab- or comma-delimited text. The
details of this window are explained below.



Figure 2: The Export Column Based Text Window

 
The RAD7 Fields section at the top of the Export Column Based Text window contains checkboxes
representing the original 23 fields inherent to each RAD7 data record. Below, the Derived Fields
section contains additional checkboxes representing properties calculated by Capture. Note that
any corresponding uncertainty values indicate statistical uncertainty; these values do not indicate
the absolute uncertainty of the RAD7.

The checkboxes in the section of the window labeled Configuration are used to specify whether
Forced SNIFF Mode, Humidity Correction, and/or B to A Spill Correction are applied to any derived
data that is being exported. If the "Express concentration values using additional significant figures
checkbox" is checked, the exported concentration values will be expressed using much greater
precision than normal. In most cases this added precision is not useful, due to the considerable
uncertainty inherent in each concentration measurement.

The Delimitation pop-up menu is used to specify whether the columns of text will be separated by
commas or tab characters. The appropriate choice here will depend on the requirements of the
program in which the exported data will be viewed. Selecting Tab Character here will produce a
plain text file with a .tsv file name extension. The Comma Character option produces a plain text
file with a .csv file name extension. Both of these file types can be directly opened in Microsoft
Excel.

Once the desired selections have been made, click the OK button. If a column-based text file is
being produced, the Save As dialog box will appear, where a name and location may be chosen
for the exported file. Note that although this data can be imported into a spreadsheet application or
opened in a word processing application, the data will not be able to be re-imported into Capture.

  Exporting RAD7 Printer Data

The Export RAD7 Printer Data command saves a textual Printer Data file, containing the
supplementary printed information associated with each RAD7 record. This information is not
available for all data sets. Choosing this option will present a Save As dialog box, in which the
name and location of the exported file may be specified.

Creating Reports When RAD7 Data is visible in a graph window, it is possible to create several different kinds of
reports using a submenu under the File Menu's Create Report command. The report options are
described below.



Figure 3: Create Report options in the File menu.

  Creating a Data Summary Report

The Data Summary Report command creates a textual Data Summary file, containing basic
information about the selected records and the RAD7 used to record them. Choosing this option
and clicking Next will present a Save As dialog box, in which the name and location of the
exported file may be specified. A sample Data Summary file is shown in Figure 4, below.

Figure 4: Sample Data Summary file

  Creating a Run Summaries Report

The Run Summaries Report command creates a text-based Run Summaries file containing
information on each run, as shown in Figure 5. Choosing this option will present the Run
Summaries window, as shown in Figure 6. This is used to specify the types of data included in the
Run Summaries file, plus any corrections applied to the data, and the formatting of the columns in
the file. Each of these parameters is explained below.

 



Figure 5: Sample Run Summaries file with text formatted for print output.

Figure 6: Export Run Summaries Window



  The Data Source pop-up menu is used to specify the source of the concentration averages
included in the Run Summaries file. This may be set to either Radon in Air or Radon in Water.

The Concentration Unit pop-up menu is used to specify the concentration unit used to express
concentration averages in the file. This may be set to Bq/L, Bq/m³, dpm/L, or pCi/L.

The Temperature Unit pop-up menu is used to specify the unit of the temperature averages in the
file. This may be set to Celsius or Fahrenheit.

The Include Thoron Data checkbox controls whether the Run Summaries file will contain columns
listing thoron concentration averages, in addition to radon concentration averages for each run.
The accompanying pop-up menu is used to specify whether all thoron readings are taken into
account when calculating the average, or only valid thoron readings. For a thoron reading to be
considered valid, the RAD7 pump must be running continuously, or the RAD7 must have been
operating in Thoron mode. (Thoron mode can be enabled from within the RAD7's Data menu.)

The Include Uncertainty in Concentration Averages checkbox controls whether the uncertainty of
the concentration averages for each run are included in the file. The average uncertainty for a run is
typically much lower than the concentration uncertainty for any given cycle within the run.

The Include Maximum Radon Concentration and Include Minimum Radon Concentration
checkboxes control whether the respective maximum and minimum radon values present in each
run are reported in the file.

The Include Standard Deviation checkbox controls whether the standard deviation of the
concentrations within each run are included in the file. The Standard Deviation value indicates the
amount of variation in the recorded radon concentrations within a run. Note that this deviation can
be due to both statistical error and actual changes in the radon concentration.

The Include Temperature and Include Humidity checkboxes control whether the average
temperature and relative humidity of each run are included in the file, respectively.

The Starting Cycle pop-up menu is used to specify the first cycle from each run that is included in
calculated averages. For example, if this menu is set to 3, then the reported concentration average
for a run containing ten cycles would be calculated based on runs 3 through 10. This is useful if the
radon levels reported for the initial cycles are not representative of the full run.

The Apply Humidity Correction, Apply Forced SNIFF Mode, and Apply BA Spill Correction
checkboxes determine which correction(s) are applied to the concentration averages reported in
the Run Summaries file. Similar controlcs are found in the Graph Controls panel, and more
information about corrections can be found in the Graph Controls Panel section.

The Format Document For pop-up menu has two options, Print and Spreadsheet. If Print is
selected, the document will be laid out in an easy to read format, as shown in Figure 5, above. The
Spreadsheet option produces a file that is not as easily readable, but better suited for data analysis
applications. If this option is selected, the Delimitation pop-up menu appears, making it possible to
specify whether the document's columns will be separated by commas or tab characters.

  Creating a Radon Inspection Report

The Radon Inspection Report command produces an HTML-based radon inspection report. The
report includes a data summary, a high resolution graph image, and a table containing complete
experimental results. The graph image is embedded inside the HTML document, making it a single
portable file that can be viewed in any web browser.

Choosing the Export Radon Inspection Report command brings up the window pictured below.
This window is used to specify the report parameters, including the name and address of the
radon testing firm, the details of the property being tested, which data records are included in the
report, and whether the Action Level is represented on the graph. If the Show Action Level Line
checkbox is checked, a red line will be drawn horizontally across the graph indicating the radon
concentration threshold at which a mitigation system is recommended. (The line color can be
changed in the Settings Window.)

Checkboxes are also provided for specifying whether Forced SNIFF Mode, Humidity Correction,
and BA Spill Correction are applied to the inspection report data. Other parameters, such as
whether the temperature and humidity graph lines are visible, the thickness of the graph lines, and
the radon concentration unit used on the graph, are based on the configuration of the associated
graph window.

Once the necessary information has been entered, click the Next... button and specify a name and
location for the report. After the report has been generated, it will automatically open in a web
browser window. From there it may be printed or exported as a PDF (provided the browser's Print
command facilitates printing documents to the PDF format).



Figure 7: The Export Radon Inspection Report window

Printing RAD7 Data When a Graph Window is visible, the radon graph can be printed at high resolution. Capture's print
commands are located in the File menu. The Print command prints the current radon graph. On
some systems, the Print dialog box may also be used to save, fax, or email a cross-platform PDF
version of the graph image. The keyboard shortcut for this operation is Control-P on Windows, and
Command-P on macOS.

The Image Output panel in the Preferences Window may be used to specify whether the selected
region appears on the printout, and whether statistics will be included on the printout.

The File Menu's Page Setup command is used to configure the page orientation and other print
settings. The Portrait orientation option places the graph on the top of the page, with graph
statistics optionally appearing below the graph image. The Landscape orientation option rotates
the graph image, allowing it to fill the entire sheet. When the Landscape option is selected, graph
statistics are displayed on a second page. Use the keyboard shortcut Control-Shift-P (Windows) or
Command-Shift-P (macOS) to bring up the Page Setup dialog.



  TOOLS MENU FUNCTIONALITY

  The Tools menu in the menu bar contains commands for conducting various calculations,
manipulating RAD8 and RAD7 Data files, and installing and disabling the RAD7's RADLINK
communications software. Note that several of these features require a Capture Pro license.
These features are explained in this section.

Event-Driven Actions The Event-Driven Actions command in the Tools menu is used to configure Capture to respond in
a variety of ways to specified occurrences. For example, when a RAD7 reports a high radon
concentration, Capture can sound an alarm or send an email. For more information, see the Event-
Driven Actions section.

Concentration Unit
Converter

The Concentration Unit Converter command in the Tools menu is used to convert a user-supplied
radon concentration value between four different concentration units: Bq/L, Bq/m3, Dpm/L, and
pCi/L. Enter a concentration value and specify a unit, and the converted values will be displayed as
shown in Figure 1, below.

 

Figure 1: Concentration Unit Converter Window

Sensitivity Unit
Converter

The Sensitivity Unit Converter command in the Tools menu is used to convert a user-supplied
RAD7 sensitivity value between four different sensitivity units: cpm/(Bq/L), cpm/(Bq/m3),
cpm/(Dpm/L), and cpm/(pCi/L). Enter a sensitivity value and specify a unit, and the converted
values will be displayed as shown in Figure 2, below.

 

Figure 2: Sensitivity Unit Converter Window

Humidity Correction
Calculator

The RAD8 and RAD7 operate less efficiently when there is a high level of humidity in the air path,
and consequently the instruments underreport the radon concentrations in such conditions. This
can normally be avoided through the use of desiccant and/or the Durridge DRYSTIK ADS-3.
However when these drying accessories are unavailable, the Humidity Correction Calculator
command in the Tools menu may be used to correct a stated radon concentration with respect to
known temperature and humidity values. When a radon concentration, temperature, and relative
humidity are specified, the corrected radon concentration will be calculated as shown in Figure 3,
below. The humidity correction algorithms for the RAD8 and RAD7 differ, so it is necessary to
specify the device type as well. Note that humidity correction can also be applied to data in a
Graph Window, as described in the Graph Controls Panel section.

ConcentrationUnitConverter

ConcentrationValue: 4.00

ConvertedValues:0.148Bq/L
148Bq/m3
8.88Dpm/L
4.00pCi/L

pCi/L

Convertedvaluesareexpressedusingthenumberofsignificantdigitsprovided.



 

Figure 3: Humidity Correction Calculator Window

Radon In Water
Calculator

The Radon In Water Calculator command in the Tools menu is used to calculate a Radon In Water
concentration based on a user-supplied Radon In Air value obtained using either the RAD AQUA,
Water Probe, or RAD H2O. It is possible to calculate a Radon In Water concentration for a RAD
H2O test that was conducted using the wrong protocol (for example Sniff protocol instead of WAT-
250 protocol).

RAD AQUA and Water Probe calculations require specifying not only the Radon in Air
concentration, but also the Water Temperature and Water Type. If the water type is set to Saline
Water, it is necessary to specify the salinity in parts per thousand.

The calculated Radon In Water Concentration is displayed at the bottom of the window, along with
the ratio of Radon in Air to Radon in Water, as shown in Figure 4, below.

 

Figure 4: RAD H2O Radon In Water Calculator Window

Combine Radon Data
Files

To combine two or more RAD8 or RAD7 Data files into a single file, choose the Combine Radon
Data Files... command from the Tools menu, and select either the Combine RAD7 Data Files... or
Combine RAD8 Data Files... option from the submenu. A Combine Data Files window will appear
as shown below.

This window lets you assemble a list of RAD8 or RAD7 data files to be combined. The data files
may be added or removed from the list using the Plus and Minus buttons. It is also possible to
drag one or more data files (as well as folders containing data files) into the list from the desktop.
When combining RAD8 data files, a "Desired Cycle Time" menu will be present, allowing you to
specify the number of minutes between data points. This value may be any multiple of 5 minutes.
When combining RAD7 data files, a "Minimum permitted record separation" field is used to specify
the threshold under which records from different files will be merged and averaged into single
records.

The Graph Combined Data and Save Combined Data to Disk checkboxes are used to specify
whether the new combined data set will be displayed in a Graph Window and/or saved to the
computer. At least one of these options must be chosen, and at least two radon data files must be
added to the list in before the combining process can proceed. If the combined radon data is to be
saved to disk, use the Select Location button to specify a name and location for the resulting data
file.

 



Figure 5: Combine RAD8 Data Files Window

  Once the desired settings have been chosen, click Continue to complete the combining process. If
there are any problems with the files being combined, the Errors Window will appear explaining the
issue in detail. Only severe data formatting problems will prevent the combining process from being
completed successfully. More information on data errors is available in the RAD7 Data Errors
section.

Resample Radon Data
File

The RAD8 records radon data at 5-minute intervals, and one or more 5-minute "data slices"
comprise a cycle, which is represented as a point on a graph. The data can be refectored, such
that the duration of each cycle can be any multiple of 5 minutes. Likewise RAD7 data can be
resampled, however the options for RAD7 data are more limited.

As an example, if a RAD8 or RAD7 is measuring a low concentration of radon and the instrument
has been configured to record cycles at frequent intervals, an unreasonably low number of radon
detection events may occur during a given cycle, and each data point may therefore have an
excessively high uncertainty value, resulting in a "noisy" record set, in which individual data points
are statistically meaningless. In many such cases a longer cycle time could have produced
statistically meaningful data points.

By downsampling a radon data file, it is possible to retroactively achieve the benefits of longer
cycle times after the data has already been recorded. During a downsampling operation the raw
count data from a series of successive cycles are averaged to synthesize a set of combined data
points. The resulting data set will consist of fewer data points than the original file, and each of the
new data points will have a comparatively longer Live Time, a greater number of total counts, and a
correspondingly lower uncertainty value.

To resample a radon Data file, choose the Resample Radon Data File... command from the Tools
menu. The Resample Radon Data File Window will appear as shown below. This window contains
a control for specifying the minimum permitted record separation; records separated by fewer than
the specified number of minutes will be averaged. Checkboxes are provided for specifying whether
to graph and/or save the downsampled data. If the data is to be saved to disk, it will be necessary
to specify the name and location of the downsampled data file.

 



Figure 6: Resample Radon Data File dialog

Shift Dates In Radon
Data File

The Shift Dates in Radon Data File command is used to modify the dates and times of the records
in a RAD8 or RAD7 data file. This feature can be useful if it is discovered that the instrument's
clock settings were incorrect when data was recorded. The record dates and times may be shifted
either forwards or backwards, by a user-specified number of days, hours, and minutes. Once the
specified time shift has been applied, a Save As dialog box appears, allowing the modified radon
data file to be saved under a new name.

 

Figure 7: Shift Dates In Radon Data File Window

Shift Dates In
Temperature Data File

The Shift Dates in Temperature Data File command is used to modify the dates and times of the
records in a temperature data file. This feature can be useful if it is discovered that a temperature
probe's clock settings were incorrect when data was recorded. The temperature record dates and
times may be shifted either forwards or backwards, by a user-specified number of days, hours,
and minutes. First it is necessary to identify the format of the temperature data in the selected file
by selecting a Temperature Data Profile. Once the format has been chosen the desired time shift
may be applied, and the modified data can be assigned a new format based on any of the built-in
Temperature Data Profiles. The Save As dialog box allows the modified temperature data file to be
resaved under a new name.

 



Figure 8: Shift Dates In Temperature Data File Window

RADLINK Operations The RADLINK Operations command opens the RADLINK Operations Window, which is used to
install and disable the RAD7's communications software, known as RADLINK. This command is
useful if a RAD7's RADLINK software is lost or if it needs to be updated to a newer version.
RADLINK enables two-way communication between the RAD7 and a computer, and an up-to-date
version of RADLINK is required for full communications functionality. The latest RADLINK update is
recommended for all users.

Before installing or removing RADLINK, it is recommended that any radon test data present on the
RAD7 first be downloaded and saved to the computer. Under normal circumstances RADLINK
installation and removal operations do not erase the RAD7's radon test data, but nevertheless
caution is advised.

RADLINK installation and removal operations require that the RAD7 be set to 1200 baud. If a
version of RADLINK is already present on the RAD7, use the SetBaud command in the RAD7's
Special menu to set the device's baud rate to 1200. If RADLINK is not present on the RAD7 this
step is unnecessary, because the device will have already reverted to 1200 baud.

From the RADLINK Operations Window, choose Install RADLINK or Disable RADLINK as shown in
Figure 9, below. If you wish to update RADLINK to a newer version, it is strongly advised to first
disable the existing version. Use the radio buttons to specify whether to install or disable RADLINK,
then click the Continue button.

 

Figure 9: RADLINK Operations Window

  If RADLINK is to be installed, specify the serial port of the connected RAD7 and its firmware
version using the pop-up menus as shown in Figure 10, below. If RADLINK is to be disabled, it is



necessary to specify only the serial port.

If you are unsure which serial port the RAD7 is connected to and there are multiple available
options in the Serial Port pop-up menu, try unplugging the RAD7's USB data cable from the
computer and then closing and reopening the RADLINK Operations Window and observing which
option is no longer made available in the Serial Port menu.

When installing RADLINK, Capture will determine which version of RADLINK to install based on the
specified firmware version. The RAD7's firmware version can be identified by observing the
instrument's LCD display immediately after powering on the device. If the firmware version
specified in the RADLINK Operations Window does not match the version present on the RAD7,
the wrong version of RADLINK will be transferred and the installation procedure will have to be
repeated.

 

Figure 10: RADLINK Installation Serial Port and Firmware Version setup

  After clicking Continue, a set of instructions will appear as shown in Figure 11, below. These
instructions will remind the user to download any existing radon test data from the RAD7 before
proceeding, in order to protect against unintentional data loss when installing or disabling
RADLINK.

If RADLINK is being installed, use the device's keypad to navigate to the Special menu, and press
the Enter key. If RADLINK is not present on the RAD7, its screen will display "Not installed. Install?"
Use the RAD7's arrow keys to switch from "No" to "Yes", and then press the RAD7's Enter key
again. Now the RAD7 is ready to receive the RADLINK software data from the computer.

If RADLINK is already on the RAD7 and you wish to disable it, navigate to the Special menu, press
Enter, and press the right arrow button several times to select S-Load. Then press Enter again. The
RAD7 will begin to await incoming RADLINK data.

 



Figure 11: Preparing to initiate a RADLINK Installation

  Click Continue to begin the RADLINK installation or disabling procedure. Installing RADLINK takes
a few minutes, and disabling RADLINK takes just a few seconds. The process can be monitored in
the RADLINK Operation Window as shown in Figure 12, below.

 

Figure 12: RADLINK Installation in progress

  When the RADLINK installation or disabling process has finished, you may close the RADLINK
Operations Window. Capture will then offer to rescan for devices, and it will detect any RAD7s on
which RADLINK has been installed. Capture will then offer to increase the speed of any newly
discovered RADLINK-enabled RAD7 from 1200 baud to 9600 baud, making communication
operations considerably faster.

Terminal Window The Terminal Window command in the Tools menu provides an interface for manually issuing serial
commands to any device that communicates using a standard serial protocol, including the RAD8,
RAD7, and DRYSTIK ADS-3. The Terminal Window is shown in Figure 13, below.



Use the Serial Port and Baud Rate pop-up menus to specify terminal connection settings, and
then click Connect to begin. Enter a command using the command line at the bottom of the
Terminal Window, and then click the Send button to issue the command. When a response is
received it will be added to the large text area at the center of the window. When communicating
with a device via the Terminal Window, other Capture features that involve device communication,
such as the Chart Recorder, will be temporarily unavailable.

 

Figure 13: Terminal Window



  THE SETTINGS WINDOW

  Many important configuration options are made available in the Capture Settings Window. This
window is accessed from the File Menu on Windows, and from the Application Menu on the
macOS. Alternatively, you can bring up the Settings Window with the control-comma keyboard
shortcut on Windows, and the command-comma shortcut on macOS. The Settings window
consists of multiple panels, the contents of which are described below.

General Panel  The General panel contains controls for specifying how Capture behaves when connecting to
RAD7s, downloading RAD7 data, and formatting the downloaded information. These controls are
described in detail below.

 

Figure 1: The General Settings Panel.

  Date Format

The radio buttons in the Date Format section is used to specify the format used to display dates
throughout the application. Dates may be displayed with the year, month, and day figures ordered
in any of three different arrangements.

  Time Format

The radio buttons in the Time Format section is used to specify the format used to display times
throughout the application. Times may be displayed in either a 12-hour or 24 hour format.

  Device Connectivity

The Scan for Connected Devices at Launch checkbox in the Device Connectivity section is used to
specify whether Capture identifies all connected RAD7s, RAD7s, and DRYSTIKs when it starts up.
If this box is left unchecked, it will be necessary to click the Scan For Devices button in the Main
Window before performing downloading data, viewing the Chart Recorder, or performing other
operations involving device interaction.

The Allow Temporary Changes to RAD7 Output Format checkbox determines whether Capture is
permitted to change the format of the RAD7's output in an effort to improve communication
performance. This option is most beneficial when downloading large numbers of records. If this
box is checked, Capture will attempt to restore the RAD7 to its previous output format after each
communication is complete.

Profiles Panel The Profiles Panel contains three tabs, labeled RAD7 Profiles, RAD8 Profiles, and Temperature
Data Profiles. RAD7 Profiles and RAD8 Profiles represent the characteristics of individual RAD7s
and RAD8s such as Sensitivty values and Spill Factor values, which affect how the instruments'
data is parsed and displayed. Temperature Data Profiles contain file format definitions that make it
possible for Capture to read the output of external third party temperature data loggers.



Temperature logging is necessary when measuring radon in water using such accessories as the
RAD AQUA and Big Bottle System, because the temperature of the water sample must be known
to derive its radon concentration. RAD7 Profiles, RAD8 Profiles, and Temperature Data Profiles are
explained in detail below.

RAD7 Profiles and RAD8 Profiles

RAD7 and RAD8 data can be more accurately interpreted and displayed on a graph if certain
information is available about the specific instrument that recorded the data. This information is
encapsulated in RAD7 Profiles and RAD8 Profiles, and managed using Capture. These Profiles are
configured within the Profiles panel in the Settings Window. The list box on the left side of each
Profile editor contains Profile names. When a Profile is selected, its details appear on the right side
of the panel. When graphing data from a particular instrument, the desired Profile may be selected
in the Graph Controls panel, and that profile's properties will influence the results shown on the
graph.

There are two types of RAD7 and RAD8 Profiles: Calibration Generated Profiles and User Created
Profiles. A Calibration Generated Profile will be created automatically when Capture connects to a
particular RAD7 or RAD8 for the first time, or when Capture detects that the instrument has been
recalibrated. These profiles contain information obtained directly from the instrument, and they can
not be modified. User Created Profiles are established manually, and they may be assigned custom
property values to suit specific usage scenarios. For example a User Created RAD7 Profile's
Thoron Sensitivity may be customized to compensate for the increased thoron decay that occurs
during thoron retrieval when a Laboratory Drying Unit is used, rather than the standard Small
Drying Tube.

The Plus [+] and Minus [-] buttons under the Profiles list box are used to add and remove User
Created Profiles. Calibration Generated Profiles may not be added manually, but existing ones may
be deleted.

 

Figure 2: A Calibration Generated RAD8 Profile.

When a Calibration Generated RAD7 or RAD8 Profile is selected, its three Sensitivity values appear
in the panel to the right, along with its CB and BA Spill Factors values. These values are obtained
automatically from the instrument.

In the case of the RAD7, the BA Spill Factor is always presumed to be 0.0250. If the RAD7
undergoes a specific calibration for thoron sensitivity, the instrument's BA Spill Factor will be
known with greater certainty, and if it differs from 0.0250, a User Created RAD7 Profile should be



added, and this known BA Spill Factor value should be assigend to the Profile.

Note that the automatic retrieveal of a RAD7's Sensitivity and Spill Factor values requires that
RADLINK is installed on the instrument.

When a User Created RAD7 Profile is selected, an full set of configuration controls appears. These
controls fall into several categories, as described below.

 

Figure 3: A User Created RAD8 Profile.

Profile Identification Settings

The first set of controls to the right of the RAD7 Profiles list box lets you specify the name of a User
Created RAD7 Profile, and (optionally) an Effective Date and RAD7 Serial number. If the latter
properties are specified, Capture will automatically select the profile when a data file with matching
properties is opened. However User Created Profiles are generally assigned manually, using the
controls in upper left corner of the Graph Window.

Radon Settings

The Radon Settings controls are used to configure a User-Created RAD7 Profile's NORMAL and
SNIFF Sensitivity settings. The Sensitivity Source pop-up menu is used to specify whether the
NORMAL and SNIFF Sensitivities are obtained automatically, versus being manually specified by
the user. If the first option is selected, the NORMAL and SNIFF Sensitivities are determined by
analyzing data obtained from the RAD7 (provided the latest version of RADLINK is present on the
instrument). If the second option is chosen, the sensitivity values must be entered by the user.

Thoron Settings

The Thoron Settings controls are used to configure a User Created RAD7 Profile's THORON
Sensitivity settings. The Sensitivity Source pop-up menu is used to specify how the THORON
Sensitivity is obtained. Capture is usually able to obtain a RAD7's THORON Sensitivity
automatically, in the same manner with which it obtains the instrument's NORMAL and SNIFF
sensitivities. If the RAD7 has been specifically calibrated for Thoron, Capture will likewise detect the
calibrated THORON sensitivity and apply it to the corresponding Calibration Generated Profile, but
it may nevertheless be advantageous to establish a User Created Profile for the thoron-calibrated
RAD7, not only to affirm the calibrated THORON Sensitivity (which is stated on the signed Thoron
Calibration Certification Report provided by Durridge), but also to accommodate the calibrated BA



Spill Factor, which is calculated only during the thoron calibration procedure. The BA Spill Factor is
explained below.

Spill Factor Settings

A RAD7's BA Spill Factor represents the degree to which radon readings must be corrected in the
presence of high thoron. This value should be manually entered in the BA Spill Factor field. It can
be obtained from the Thoron Calibration Certification Report provided by Durridge after a RAD7
has been specifically calibrated for thoron. If a specific thoron calibration has not been conducted,
use the default value of 0.0250.

A RAD7's CB Spill Factor represents the degree to which thoron readings must be corrected in the
presence of high radon. The CB Spill Factor Source pop-up menu is used to specify whether the
CB Spill Factor is obtained automatically, versus being manually specified by the user. It may be
obtained automatically from the RAD7 if the instrument contains the latest version of RADLINK.
Otherwise, it should be entered manually. The CB Spill Factor value can be obtained from the
signed RAD7 Calibration Certificate provided by Durridge.

  Temperature Data Profiles

When a RAD AQUA, Water Probe, or Big Bottle System is used to collect radon data from an
underwater source, Capture accounts for the water temperature in order to calculate the exact
radon in water concentration. The necessary calculations are performed automatically, but usually
it is necessary to provide Capture with a Temperature Data File consisting of water temperature
records obtained using a temperature logging device. The RAD7 itself is not equipped to record
water temperatures.

A temperature logging device with a serial or USB interface should be used to record water
temperature values at appropriate intervals. After the temperature data has been recorded to the
logger, the data must be transferred to the computer. Capture has built-in support for the EL-USB-
TC temperature logger manufactured by Lascar Electronics. Software for obtaining temperature
data from other loggers is available from the device manufacturer.

Capture can only interpret temperature data properly if it is given a complete definition of the
format in which the data is stored. The Settings Window's Temperature Data Profiles tab provides
controls for specifying these formats.

 

Figure 4: A Temperature Data Profile.



The Temperature Data Profiles list on the left side of the window contains the names of each
profile. Capture comes bundled with a collection of built-in profiles, which allow it to read data files
that have been saved using utilities available from the manufacturers of popular temperature
loggers. These utilities include features for exporting temperature data to a text file which can be
read by Capture. Since Capture does not include Temperature Data Profiles for every manufacturer,
it may be necessary to define a custom Temperature Data Profile before the temperature data can
be read by Capture.

The Plus (+) and Minus (-) buttons under the Temperature Data Profiles list box are used to create
and delete Temperature Data Profiles. Each profile consists of several configurable properties,
including Name, Starting Row, Separator, Temperature Unit, and Date Format. Profiles also contain
properties indicating which columns contain the Date and Temperature value of a reading. All of
these can be modified using the controls on the right side of the window, which are described
below. Note that the built-in Temperature Data Profiles can not be modified or deleted.

  Name Field

The Name field contains the name of the selected Temperature Data Profile. Temperature Data
Profiles should be given easily recognizable names, such as "Onset HOBOWare CSV Data". In this
example, Onset is the name of the company that supplied the temperature logger, HOBOWare is
the name of the software that is used to extract the data from the logger, and "CSV" indicates that
the data is stored using the command Comma Separated Values delimitation format.

  Starting Row Field

The Starting Row Field indicates which row contains the first line of actual data. For example, if the
first line of a data file contains the column headings, then the Starting Row is likely row 2. In some
cases the file's header may occupy two or more lines, increasing the Starting Row accordingly.

  Separator Pop-Up Menu

The Separator Pop-Up Menu is used to specify whether data fields are separated by commas or
tab characters. Commas have become a popular delimitation character in recent years, with the
growth of the CSV ("Comma Separated Values") format.

  Temp. Unit Pop-Up Menu

The Temp Unit Pop-Up Menu is used to specify whether temperature data is stored in the
Fahrenheit or Celsius scale.

  Date Format Pop-Up Menu

The Data Format Pop-Up Menu is used to specify whether date is expressed in Month/Day/Year
format, Day/Month/Year format, or Year/Month/Day format.

  Date Pop-Up Menu

The Date Pop-Up Menu is used to specify which data column contains dates and times. This
information should be in a standard format; for example 09/06/10 06:09:37.0.

  Temp. Pop-Up Menu

The Temp. Pop-Up Menu is used to specify which data column contains temperature data.
Temperature values may be expressed in either Celsius or Fahrenheit units.

 
As you configure a Temperature Data Profile's properties, it may be useful to load a sample
temperature data file for the purpose of validating the configuration. To do this click the Replace
Sample Data button and select a temperature data file. If the Profile's properties have been
specified correctly, the Sample Data table will be filled with organized, identifiable data, and Date
and Temperature headings will appear at the top of the appropriate columns. The green text under
the Sample Data table will display the date and temperature values extracted from the row
selected in the Sample Data table.

Colors Panel The Colors panel provides access to controls for customizing the colors used when rendering
graph lines. The Colors panel also contains controls for adjusting the opacity of graph content, and
restoring the default color settings.

 



Figure 5: The Colors Settings Panel.

Graph Line Colors

Colors for each graph line can be changed by clicking the corresponding rectangle and selecting a
replacement color from the standard system color picker.

  Lightened Graph Line Opacity Slider

The Lightened Graph Line Opacity Slider is used to control the opacity of the rough data lines that
appear in the background of the graph when smoothing is enabled.

  Grid Line Opacity Slider

The Grid Line Opacity Slider is used to control the opacity of the horizontal and vertical grid lines
that may be displayed in the background.

  Restore Default Colors Button

The Restore Default Colors button removes any custom colors and reverts to the original color
settings.

Image Output Panel The Image Output panel provides access to controls for customizing the appearance of graph
images that are printed and saved to disk.

 



Figure 6: The Image Output Settings Panel.

Highlight Selected Region On Printout Checkbox

Determines whether the selected region is highlighted on the printed graph output.

Show Statistics On Printout Checkbox

Determines whether statistics pertaining to the selected region appear on the printed output. Note
that these statistics can only appear if the printout uses a portrait orientation. Printed graphs that
use the landscape orientation take up the entire page, leaving no room for statistics.

Highlight Selected Region On Copied Image Checkbox

Determines whether the selected region is highlighted on the image when it is copied to the
clipboard.

Highlight Selected Region On Graph Picture Checkbox

Determines whether the selected region is highlighted on the image when it is saved to disk.

Alerts Panel The Alerts panel contains controls used to specify which common alert messages are disabled.
Each individual message can also be suppressed by clicking its "Do not show this message in the
Future" checkbox before dismissing it. The purpose of each alert message is described under the
checkbox used to disable it.

 



Figure 7: The Alerts Settings Panel.

Security Panel The Security panel provides access to controls for excluding certain serial ports when scanning for
devices, and for protecting RAD7s from commands issued by unauthorized Internet Protocol (IP)
addresses.

 

Figure 8: The Security Settings Panel.

Serial Port Scanning

The Serial Port Scanning controls are used to omit specified serial ports from the scanning process
which is used to detect connected devices. This is useful if a particular serial port should be
reserved for another application, or if the process of opening a particular port causes delays while
launching Capture.

If the Allow scanning of all serial ports radio button is selected, each serial port on the computer
will be scanned when searching for connected devices.

If the Do not scan certain serial ports radio button is selected, then the serial ports that have been
entered into the Serial ports to skip list will be be omitted from the scanning process. Use the Plus
(+) and Minus (-) buttons to add and remove serial ports to and from the list.

Relay Device Command Security

The Relay Device Command Security controls are used to identify the computers that will be
permitted to send commands to connected RAD7s.

If the Allow Commands From All Addresses radio button is selected, commands may be relayed to
a connected RAD7 regardless of the IP address of the computer sending the commands.

If the Allow Commands From Certain Addresses radio button is selected, then only computers
using the IP addresses that have been entered into the Permitted IP Addresses list will be allowed
to issue commands. Use the Plus (+) and Minus (-) buttons to add and remove addresses to and
from the list.

Updates Panel The Updates panel provides access to controls for checking to see if updates are available for
Capture. It is also possible to configure Capture to check for updates automatically.

 



Figure 9: The Updates Settings Panel.

Check For Updates Checkbox

Determines whether Capture will automatically check for updates at scheduled intervals. When an
update becomes available, a button labeled Update Available will appear in the lower right corner
of the Main Window. Clicking this button initiates the updating process.

Check frequency Pop-Up Menu

This pop-up menu determines how often Capture performs automatic checks for updates. Capture
may be set to check for updates every time it opens, daily, weekly, or monthly.

Check Now Button

Checks for Capture updates immediately, regardless of the above scheduled update settings.

Advanced Panel The Advanced panel provides access to controls for specifying numerical precision settings,
methods of calculating the uncertainty in averages, and the Bismuth-212 Branching Ratio, which
affects the calculation of radon concentrations on the RAD7.

 

Figure 10: The Advanced Panel.

Match Significant Figures to Precisions Checkbox

The Match Significant Figures to Precision checkbox is used to specify whether radon and thoron
concentrations are expressed using fewer significant digits when the associated uncertainties are
high. If this box is checked, an uncertainty greater than 150% of the base value will cause the



concentration to be expressed using only one significant digit; an uncertainty greater than 15% of
the base value will cause the concentration to be expressed using two significant digits; an
uncertainty greater than 1.5% of the base value will cause the concentration to be expressed using
three significant digits; and so on.

Normally uncertainties are expressed using two significant digits, and base concentrations are
always expressed using the same number of digits to the right of the decimal point as in the
uncertainty value.

Uncertainty Calculation for Average of a Selection Options

There are two Uncertainty Calculation options: Base Uncertainty on Number of Counts, and Base
Uncertainty on Scatter of Points. Basing the uncertainty on the Number of Counts involves Poisson
statistics, and is applicable even when there is a significant variation in radon concentration during
the period of the measurement. Basing the uncertainty on the Scatter of Points is applicable when
there are more than ten readings and it is known that the radon concentration was steady during
the period selected.

Please note that the uncertainty, as displayed, refers only to the statistical uncertainty of the result.
This is a measure of the precision of the reading. The result ignores any systematic bias due to
uncertainty in the calibration, and traceability to national standards, which may be as much as
±5%.

Bismuth-212 Branching Ratio Options

When Thoron decays, it eventually produces bismuth-212, which has a chance to decay i) into
polonium-212 (via beta emission), then lead-210 (via alpha emission), or ii) into thalium-208 (via
alpha emission). In case i), the alpha decay of polonium-212 produces a count that appears in the
D window. In case ii), the direct alpha decay of bismuth-212 produces a count that appears in the
A window.

The RAD8 and RAD7 use the A window counts to calculate the displayed radon activity
concentration. Therefore, when measuring radon, it is necessary to discount the portion of the A
Window counts that came from the direct decay of bismuth-212 in the thoron decay chain. Since
the ratio of thoron-genic counts in the D window to those in the A window is fixed by nature,
knowing the D window counts gives the instrument all the information it needs to correct the A
window count for interference from thoron. The RAD7 accomplishes this by subtracting half of the
D Window Counts from the A Window. However, the accepted value from the scientific literature
(calculated by the Laboratoire National Henri Becquerel â€“ LNHB - as the weighted average of
four independent measurements made throughout the 1960s) is 0.5611, so Capture offers this as
option as well, for increased accuracy.

This bismuth-212 branching ratio is only consequential when measuring a low radon concentration
in the presence of a high thoron concentration. Furthermore, this option only applies to RAD7 data.
RAD8 data analysis always uses the LNHB value of 0.5611.



  TROUBLESHOOTING

  The most common problems users encounter with Capture involve the program failing to start up
properly, the failure to detect connected RAD7s, and errors in downloaded RAD7 data. Solutions
to these issues are described below.

Capture Fails to
Launch  

If Capture fails to launch on Windows XP and displays a dialog box similar to the one shown
below, it may be because the version of Capture that has been installed is too new to run on an
older operating system. The solution is to install a legacy version of Capture. See the the Legacy
Versions of Capture page on the Durridge website for details.

If Capture launches but fails to display the splash screen and the Main Window, it may be the result
of a problematic settings file. The solution is to restore the default settings file. This is achieved by
holding the Shift and Control keys as Capture starts up. A dialog box will appear prompting for a
confirmation to proceed with the operation.

If this dialog box is not immediately visible, check to make sure that it is not hidden behind a folder
or other window. Once the settings have been reset, Capture will start up normally. Be advised that
all custom-configured RAD7 profiles and other settings will be lost.

Capture Launches
Slowly  

When Capture starts up, it examines each serial port on the computer, including Bluetooth-enabled
serial ports, to determine which ones can be used to communicate with RAD7s and other devices.
Usually this process takes a fraction of a second for each port, but under certain conditions it can
take substantially longer. If Capture is taking a long time to launch, it may be because it is
evaluating one or more problematic serial ports. To avoid this, unpair and delete any unneeded
Bluetooth devices, such as mobile phones, Bluetooth audio speakers, and improperly configured
Bluetooth to serial adapters. The process for removing such devices differs depending on the
operating system version.

Device Detection
Failure

If Capture is unable to detect a connected RAD7 or DRYSTIK, the following steps may be helpful.

General Solutions:

Make sure you are using the latest version of Capture. It can be downloaded free of charge
from the Durridge website.
Make sure your computer is running a supported operating system. The supported
operating systems are listed in the System Requirements section.
Make sure the appropriate serial to USB drivers are installed on your computer. Drivers for
the included adapter are available on the Durridge website.
Make sure the correct cables are being used and all of the cable connections are secure.
See below for specific details for each type of device.
Make sure the device is powered On.
If the device is not detected when connected to a particular USB port, try connecting it to a
different USB port on the computer.
Check the Security panel in the Capture Settings Window to make sure the serial port to
which the device is connected is not being skipped when scanning for devices.
Make sure your computer is not running anti-virus software or any program that could
interfere with Capture. This includes any other software that communicates using serial
ports.



RAD8 Detection Solutions:

Make sure the waterproof USB Mini-B connector provided with the RAD8 is fully screwed
into the RAD8's COM port.
Make sure the RAD8's battery has a healthy state of charge. If the battery is low, connect
the RAD8's power supply to recharge the battery.
Make sure the RAD8 is using the latest firmware version. To install any available firmware
updates, connect the RAD8 to Wi-Fi and go to the RAD8's System Settings menu. Choose
Firmware Update on the second page of system settings, and press the Check for Updates
Now button. Note that the RAD8's current firmware version is stated on the RAD8s About
screen and the Firmware Update screen, and the latest available version is stated on the
RAD8 Firmware Version History webpage.

RAD7 Detection Solutions:

Make sure the RAD7 is connected to the computer properly. If the computer has a built-in
serial port, simply use a null modem cable (DB9 female to female). If a StarTech USB to
serial adapter cable is being used, connect the USB end of the adapter cable to the
computer, and the serial end of the cable to the RAD7. If a Keyspan USB to serial adapter is
being used, connect the adapter to the computer and to the RAD7 using a USB-B cable
and a null modem cable, respectively. See the diagram in the Setting up the Instrument
section for details. Be aware that null modem cables have 9 holes at each end; standard
serial cables are not supported, nor are gender changer adapters that convert one end of a
serial cable from male to female.
Make sure the RAD7's battery is charged or charging.
Make sure the RAD7 has RADLINK installed. (To verify that it is installed, use the keypad to
navigate to the Special menu, and press Enter. If "Special Ident" appears, then RADLINK is
installed correctly.) If RADLINK is not installed, use Capture to install it. See the RADLINK
Operations Section for detailed instructions. Note that it is possible to download data from
a RAD7 that does not have RADLINK installed: use the Manual Download procedure
described in the Obtaining RAD8 and RAD7 Data section.
Using the RAD7's keypad, select Special → SetBaud to change its baud rate, switching
between 9600 and 19200. Performing keypad commands such as this may help the RAD7
to "wake up".
Make sure the RAD7's baud rate is not set any lower than 1200. (Capture does not support
baud rates of 300 or 600.) The recommended baud rate is 9600.
If nothing else works, it is possible that the RAD7's RADLINK software is present but
compromised. Reinstall RADLINK by following the instructions in the RADLINK Operations
section.

DRYSTIK Detection Solutions:

Make sure the DRYSTIK is connected to the computer properly. The DRYSTIK ADS-3
requires a USB B-Type cable, and the DRYSTIK ADS-3R requires a USB Mini-b cable.
Make sure the DRYSTIK is connected to a power source using the supplied power adapter.
On macOS computers, if the DRYSTIK was previously recognized but failed to be
recognized after powering it Off and back On or after disconnecting and reconnecting the
USB cable, restart the computer. This will reestablish the serial interface used to
communicate with the instrument.

After performing the above checks, if the device is still not recognized, try restarting the device and
your computer. If another computer is available, try to connect on the other one.

It is important to determine whether the problem lies with the instrument or with the computer. This
requires connecting a different serial device that is known to work, such as a modem or other
instrument. Use a terminal emulation program such as Durridge Terminal or TerraTerm, and
attempt to communicate with the device. If communication is successful, then it is possible that
there is a problem with the instrument or Capture. If communication is unsuccessful, then it is more
likely that the computer is not properly configured with the serial to USB adapter driver.

RAD7 Data Errors When RAD7 Data is opened in Capture the program evaluates the data, and if one or more
problems are detected a notification will appear at the top right corner of the graph display, along
with a button labeled "Details..." Clicking this button displays the Data Errors Window, which lists
the problems in the data set. The Data Errors Window can also be opened by choosing the Show
Data Errors... command in the File Menu.

Data records that are too damaged to be parsed will not be displayed as points on the graph, and
Capture will identify such records in the Data Errors Window using octagonal stop sign icons.
Records that are problematic but salvageable will appear on the graph, and they will be identified in
the Data Errors Window using alert icons. Records that are only slightly problematic will be
identified in the Data Errors Window using information icons.



Zero Live Time Notifications

It is not uncommon for a message such as the following to appear in the Data Errors Window:

One or more records contain Live Time readings of zero, indicating that the RAD7 did
not record data during certain cycles. This does not necessarily indicate a hardware
malfunction. These records can not be displayed on the graph. The following records
were affected:
2017/11/21 17:13 [301,17,11,21,17,13, 0., .0, 0.0, 0.0, 0.0, 0.0,2218,16, 24.3,54,...
2018/02/02 22:31 [570,18,02,02,22,31, 0., .0, 0.0, 0.0, 0.0, 0.0,2218,14, 16.1,50,...
2018/02/03 10:20 [594,18,02,03,10,20, 0., .0, 0.0, 0.0, 0.0, 0.0,2218,15, 16.7,49,...
2018/02/03 16:04 [595,18,02,03,16,04, 0., .0, 0.0, 0.0, 0.0, 0.0,2201,14, 17.0,50,...
2018/02/05 11:04 [602,18,02,05,11,04, 0., .0, 0.0, 0.0, 0.0, 0.0,2218,15, 15.5,46,...
2018/03/02 18:08 [605,18,03,02,18,08, 0., .0, 0.0, 0.0, 0.0, 0.0,2201,16, 23.1,54,...

This message indicates that the Live Time values for some of the RAD7 data cycles was zero,
which means that the operation of the RAD7 was interrupted at or near the beginning of the cycle,
and the instrument did not actively record data for that particular cycle. This can occur if the RAD7
keypad is used to choose 'Test Save' before a radon measurement has started, causing the
current cycle to be stored with a recorded duration of zero. It can also be caused if 'Test Save' is
used to advance to the next cycle within the first 6 seconds of a cycle's progress.

Radon concentrations are calculated by dividing the count rate by the Live Time, so when the Live
Time is zero the reported radon concentration may be reported as a nonsensical number,
rendering the cycle invalid. This problem does not compromise the integrity of the other cycles in
the data set, so the remaining data points will still appear on the Capture graph.

Printing Errors Capture's Print command may fail on certain Windows 7 configurations. If this happens it is
recommended to use the File menu's Save Graph Picture command instead of the Print
command, and then open the resulting PNG image in a different program for the purpose of
printing. Another solution is to install the legacy version of Capture for Windows. See the the
Legacy Versions of Capture page on the Durridge website for details.

Windows Display
Problems

On Windows 10 systems, the labels on graphs and status bars may appear misaligned if the
display is set to an irregular scale setting. To correct this, go to the Start Menu and choose
Settings, then open the Display panel. In the Scale and Layout section, set the size of the on-
screen elements to a whole value such as 100% or 200%, as shown in the screenshot below.



Reporting Capture
Problems

If you think you have found a bug in Capture, please let us know. Durridge's software development
staff can be contacted at software@durridge.com.

Durridge Company is committed to Capture's continuous improvement. We achieve this by
implementing bug fixes and new features in response to user input. Your feedback is extremely
valuable.



  APPENDIX A: MENU BAR COMMANDS

Capture's menu bar houses several commands that are not accessible elsewhere in the user
interface. The location of certain menu items may differ depending upon the platform on which
Capture is running.

Keyboard Shortcut
Guide  

Several menu commands have keyboard shortcuts, which are listed below. On Microsoft
Windows, the Control key is used in conjunction with another key to trigger a keyboard equivalent,
while the Macintosh utilizes the Command key for this purpose.

Menu Menu Command Windows Shortcut  macOS Shortcut

File Open Data File... Control-O Command-O

File Open Sample Data File... (none) (none)

File Open Recent... (none) (none)

File Close Control-W Command-W

File Save Control-S Command-S

File Save As... Control-Shift-S Command-Shift-S

File Save to Capture Cloud... Control-Alt-S Command-Option-S

File Save Graph Picture... (none) (none)

File Export Device Output... (none) (none)

File Export Selected Data → RAD7 Data File... (none) (none)

File Export Selected Data → Column-Based
Text File... (none) (none)

File Export Selected Data → Column-Based
Text to Clipboard... (none) (none)

File Export Selected Data → RAD7 Printer
Data... (none) (none)

File Create Report → Data Summary Report... (none) (none)

File Create Report → Run Summaries
Report... (none) (none)

File Create Report → Radon Inspection
Report... (none) (none)

File Add Annotation... Control-T Command-T

File RAD7 Data Parameters... Control-I Command-I

File Run/Chart Parameters... Control-R Command-R

File Show Data Errors... Control-E (none)

File Show Data File On Disk (none) (none)

File Show Data In Capture Cloud (none) (none)

File Show Program Logs (none) (none)

File Show Chart Recorder Logs (none) (none)

File Page Setup... Control-Shift-P Command-Shift-P

File Print... Control-P Command-P

File Settings... Control-Comma  Command-Comma 

Edit Cut Control-X Command-X



Edit Copy Control-C Command-C

Edit Paste Control-V Command-V

Edit Clear (none) (none)

Edit Select All Control-A Command-A

Edit Snap Selection to Nearest Run(s) Control-Alt-R Command-Option-R

View Zoom In Control-Plus (+) Command-Plus (+)

View Zoom Out Control-Minus (-) Command-Minus (-)

View Reset Zoom Level Control-Zero (0) Command-Zero (0)

View (All other View menu commands)   (none) (none)

Tools Event-Driven Actions Control-E Command-E

Tools (All other Tools menu commands) (none) (none)

Window  Show Log Window  Control-L Command-L

Window   Show Chart Recorder Spectrum  (none) (none)

Window   Show Spectrum  (none) (none)

Window   Show Statistics  (none) (none)

Window   Main Window  Control-M Command-M

Window   Clean Up Window Arrangement (none) (none)

File Menu   Open Data File...

Opens an existing RAD7 Data File in a new graph window. Keyboard shortcut:
[Control/Command]-O.

Open Sample Data File...

Opens one of the built-in sample RAD7 Data Files in a new graph window.

Open Recent

Opens a recently opened RAD7 Data File in a graph window.

Close

Closes the window that is currently in front. If the Graph Window is in front, closing it brings the
Main Window to the front. Closing the Main Window causes Capture to quit. Keyboard shortcut:
[Control/Command]-W.

Save

Saves the contents of the current Graph Window to disk. The data is saved in the R7CDT file
format. This command is only available when a Graph Window is open and the graph data has
been modified.
Keyboard shortcut: [Control/Command]-S.

Save As

Saves the contents of the current Graph Window to disk. The data is saved to a new file using
either the R7RAW or R7CDT file format. This command is available when a Graph Window is open.
Keyboard shortcut: [Control/Command]-Shift-S.

Save To Capture Cloud...

Saves the contents of the current Graph Window to Capture Cloud. This command is available
when a Graph Window is open and the user is signed in to their Capture Cloud account.
Keyboard shortcut: [Alt/Option]-[Control/Command]-S.



Save Graph Picture...

This command saves the graph picture to a PNG image file. The Save Graph Picture dialog box
contains fields used to specify the desired width, height, and label scale of the graph picture. The
label scale may range from 1.0x to 3.0x, with 1.0 representing the typical size seen in a Graph
Window. The chosen scale dictates the minimum allowable image dimensions. Macintosh users
may prefer to utilize the Print command to save graph images in the PDF format, which described
below. The Save Graph Picture command is only available if a Graph Window is visible.

Export RAD7 Output...

Exports the contents of the RAD7 Output text area, which is located in the Issue RAD7 Command
panel. This menu item is only available when the Main Window is active and the Issue RAD7
Command panel is visible.

Export Selected Data

Provides several RAD7 data export options. These include RAD7 Data File, Column-Based Text
File, Column-Based Text to Clipboard, and RAD7 Printer Data. This command is only available if
the selection contains one or more data points. Detailed information on these exporting options is
available in the Exporting RAD7 Data section.

Create Report

Provides several report creation options. These include Data Summary Report, Run Summaries
Report, and Radon Inspection Report. This command is only available if the selection contains one
or more data points. Detailed information on these exporting options is available in the Creating
Reports section.

Add Annotation...

This command is used to add an annotation to a graph. Annotations are text notes that can be
pinned to particular data points, or to a specified date on the graph timeline. Keyboard Shortcut:
[Control/Command]-T.

RAD7 Data Parameters...

When a Graph Window is visible this command brings up the RAD7 Data Parameters Window.
This window is used to assign Name, Description, and Data Tag properties to a RAD7 data file.
Data files stored in Capture Cloud can be searched for using these criteria, so it is helpful to assign
descriptive parameters indicating the project, team, and/or location associated with the data.
Keyboard Shortcut: [Control/Command]-I.

Run/Chart Parameters...

When a Graph Window is visible this command brings up the Run Parameters Window. When the
Chart Recorder is visible, this command brings up the Chart Parameters Window. These windows
are used to specify the Radon Measurement Method (such as Radon in Air, RAD AQUA, Water
Probe, etc.), as well as any necessary water temperature and salinity information, and RAD7
accessory specifications. In the Run Parameters Window, the chosen parameters may be applied
to either the selected run(s) or to all of the runs in the RAD7 data set. Keyboard Shortcut:
[Control/Command]-R.

Show Data Errors...

This command shows the Data Errors Window, which reports any problems with the current graph
data. This command is only enabled if there are one or more problems with the data. Keyboard
Shortcut: [Control/Command]-E.

Show Data File On Disk

This command reveals the current RAD7 data file on the desktop.

Show Data in Capture Cloud

This command reveals the current RAD7 data file in the Capture Cloud Data Browser.

Show Program Logs

This command reveals the folder containing the Capture Program Logs. A new log file is created
for each day that Capture is used. These files may be safely moved or deleted at any time.

Show Chart Recorder Logs



This command reveals the folder containing logged Chart Recorder data files. This data
accumulates automatically whenever Capture's Chart Recorder is in use. The files may be safely
moved or deleted at any time.

Page Setup...

This command is used to configure print settings. Before printing a radon graph, it may be useful
to choose the Page Setup command and set the page orientation to Landscape, so that the graph
will fill the page more effectively. This command is only available if the Graph Window is visible.
Keyboard shortcut: [Control/Command]-Shift-P.

Print...

Prints the current radon graph. On the Macintosh, the Print dialog box may be used to save, fax, or
email a cross-platform PDF version of the graph image. This command is only available if the
Graph Window is visible. Keyboard shortcut: [Control/Command]-P.

Settings

Displays the Capture Settings Window, which contains controls used to specify a wide range of
options as described in the Settings Window section. Note that on the Macintosh, the Settings
menu command is located under the Application menu. Keyboard Shortcut: [Control/Command]-
Comma.

Exit

Exits Capture. Note that on the Macintosh, the Exit menu command is labeled Quit and is located
under the Application menu.

Edit Menu   Cut

The Cut command may be used while editing text in various fields throughout the application.
Keyboard shortcut: [Control/Command]-X.

Copy Graph Picture

If the Graph Window is open, the Copy Graph Picture command puts the graph image on to the
clipboard. Once the graph image is on the clipboard, it may be pasted into a graphics application
where it can be edited or saved. Keyboard shortcut: [Control/Command]-C.

Paste

The Paste command may be used while editing text in various fields throughout the application.
Keyboard shortcut: [Control/Command]-V.

Clear

The Clear command may be used while editing text in various fields throughout the application.

Select All

The Clear command may be used while editing text in various fields throughout the application.
Keyboard shortcut: [Control/Command]-A.

View Menu   Concentration Units

Determines the unit of measurement used to denote radon concentrations on the graph. The
available options include Automatic, Bq/m3, dpm/L, and pCi/L. The Automatic option causes the
radon concentration to be presented in the unit in which it was originally recorded inside the RAD7.
This command is only available if the Graph Window is visible.

  Temperature Units

Determines the unit of measurement used to denote temperature data on the graph. The available
options include Automatic, Celsius, Fahrenheit, and Kelvin. The Automatic option causes the
temperature data to be presented in the unit in which it was originally recorded inside the RAD7.
This command is only available if the Graph Window is visible.

  Forced SNIFF Mode

  Determines whether the graph data is forced to be displayed as if it was recorded in SNIFF Mode.



This menu command is enabled whenever there exists at least one record that truly was recorded
in SNIFF Mode. Such records are analyzed to determine the necessary SNIFF sensitivity data.

  Correct for Humidity

  Determines whether the graph data is corrected for humidity. When relative humidity is high, radon
concentration values are often underreported. Humidity correction compensates for this.

  Correct for B to A Spill

  Determines whether correction is applied based on the spill from the B to A windows. Significant
spill occurs when the thoron concentration is high relative to the radon concentration. Under these
conditions it is recommended that the data be corrected to compensate.

  Point Style

  Determines the appearance of the data points on the graph. The options are Normal, Shapes,
B&W (Black and White) Shapes, and Hidden. The B&W Shapes option causes the graph to be
rendered in black and white, which is useful when graph image is printed on a non-color printer.

Line Weight

Determines the thickness of the graph lines, as measured in pixels. This value may range from 1 to
4, or lines may be hidden. A thicker line may be easier to read, but is somewhat less precise than a
single-pixel line. This command is only available if the Graph Window is visible.

  Smoothing

Determines the degree of smoothing applied to the graph line. This value may range from 1 (no
smoothing) to 9 (high smoothing). When the degree of smoothing is greater than 1, the original,
non-smoothed graph line appears faded in the background. This command is only available if the
Graph Window is visible.

  Show Grid Lines

  Determines whether horizontal and vertical grid lines are visible on the graph.

Show Graph Legend

Determines whether the legend is visible on the Graph Window. The legend indicates the
significance of the colors that appear on the graph. This command is only available if the Graph
Window is visible.

Show Error Bars

Determines whether error bars are visible on the graph. Error bars indicate the uncertainty of radon
and thoron readings.

Show Selection Average

Determines whether a representation of the average of the selection is displayed between the
Selection Bars.

Show Selection Slope

Determines whether the Selection Slope Line will be displayed between the Selection Bars.

Selection Slope Time Unit

Determines which time unit is used to represent the Selection Slope. The time unit may be Months,
Days, Hours, Minutes, Seconds, or Automatic. If Automatic is chosen, the Time Unit will be chosen
based on the scope of the selection.

Zoom In

Causes the radon graph to zoom in, displaying a shorter time range in greater detail. This
command is only available if the Graph Window is visible. Keyboard shortcut: [Control/Command]-
Plus.

Zoom Out

Causes the radon graph to zoom out, displaying a greater time range in lesser detail. This
command is only available if the Graph Window is visible. Keyboard shortcut: [Control/Command]-
Minus.



Reset Zoom Level

Causes the radon graph to zoom all the way out, displaying the full time range needed to show all
the data. This command is only available if the Graph Window is visible. Keyboard shortcut:
[Control/Command]-0.

Radon/Thoron/Temperature/Relative Humidity Scale

These menu options determines whether the Y scales of each data type is determined
automatically or manually. Manual Y scale settings for radon, thoron, temperature, and relative
humidity may be configured in the Graph Controls panel.

  Graph Lines

  Determines which data lines are visible on the graph. The possible graph lines include Radon,
Thoron, Radon in Water, Thoron in Water, Air Temperature, Water Temperature, and Relative
Humidity.

Tools Menu   Event-Driven Actions...

Displays the Event-Driven Actions Panel in the Main Window, which is used to configure Capture to
respond in a variety of ways to specified occurrences. More information is available in the Event-
Driven Actions section.

  Concentration Unit Converter...

Opens the Concentration Unit Converter Window, which is a tool for converting expressions of
radon concentration between four different units: Bq/L, Bq/m3, Dpm/L, and pCi/L. More
information is available in the Tools Menu Operations section.

  Sensitivity Unit Converter...

  Opens the Sensitivity Unit Converter Window, which is a tool for converting expressions of RAD7
measurement sensitivity between four different units: cpm/(Bq/L), cpm/(Bq/m3), cpm/(Dpm/L), and
cpm/(pCi/L). More information is available in the Tools Menu Operations section.

  Radon In Water Calculator...

  Opens the Radon In Water Calculator Window, which is used to compute Radon In Water
concentrations based on user-supplied Radon In Air values obtained using the RAD H2O, RAD
AQUA, or Water Probe. More information is available in the Tools Menu Operations section.

Combine Radon Data Files...

This command combines two or more data files on one graph. Records separated by fewer than a
specified number of minutes are averaged. The combined data may be graphed and/or saved to
disk. More information is available in the Tools Menu Operations section.

Resample Radon Data File...

This command resamples the records in a RAD8 or RAD7 data file, changing their cycle durations.
The resampled data may be graphed and/or saved to disk. More information is available in the
Tools Menu Operations section.

  Shift Dates In Radon Data File...

  Opens the Shift Dates In Radon Data File Window, which is used to modify the dates and times of
the records in a RAD8 or RAD7 data file. If an instrument's clock settings are incorrect when data
is recorded, this feature can be used to correct the problem. The cycle dates and times may be
shifted either forwards or backwards, by a user-specified number of days, hours, and minutes.
More information is available in the Tools Menu Operations section.

  Shift Dates In Temperature Data File...

  Opens the Shift Dates In Temperature Data File Window, which is used to modify the dates and
times of the records in a temperature data file. If the logger's clock settings are incorrect when data
is recorded, this feature can be used to correct the problem. The cycle dates and times may be
shifted either forwards or backwards, by a user-specified number of days, hours, and minutes.
More information is available in the Tools Menu Operations section.

RADLINK Operations...



Opens the RADLINK Operations Window, which is used to install and remove RADLINK from the
RAD7. This command is useful if a RAD7's RADLINK software is lost or if it needs to be updated.
The latest version of RADLINK is required for full communications functionality between the RAD7
and the computer. More information is available in the Tools Menu Operations section.

Terminal Window...

Opens the Terminal Window, which provides an interface for manually issuing serial commands to
any device that communicates using a standard serial protocol, including RAD7s and DRYSTIKs.
More information is available in the Tools Menu Operations section.

Window Menu   Show Log Window

Determines whether the Log Window is visible. This window contains a record of the operations
that Capture has performed since the application was launched, plus a log of the data that has
arrived through each serial port. Keyboard shortcut: [Control/Command]-L.

Show Chart Recorder Spectrum

This command is available when the Main Window is in the front. It displays a diagnostic window
containing a multi-column histogram representing the current spectrum for the selected RAD8 or
RAD7. See the Chart Recorder section for more information.

Show Spectrum

Determines whether the Spectrum panel is visible. This command is only available when the Graph
Window is visible.

Show Statistics

Determines whether the Statistics panel is visible. This panel displays a range of information on the
data being displayed on the graph. This command is only available when the Graph Window is
visible.

Main Window

Opens the Main Window, if necessary, and brings it to the front. Keyboard Shortcut:
[Control/Command]-M

Clean Up Window Arrangement

Moves each open window to its default location on the screen. If multiple graph windows are
visible, they are arranged in a cascading pattern such that each window's title bar is visible.

Graph Window Menu Items

The Window Menu contains the names of each of the Graph Windows that is currently open.
Selecting a Graph Window here brings it to the front.

Help Menu   Capture Help...

Displays the Capture User's Manual.

About Capture...

Displays the Capture About Box, which provides basic information about Capture, as well as
buttons for accessing Help and Credits. Note that on the Macintosh, the About option is located
under the Capture Menu.



  APPENDIX B: TOOLBAR COMMANDS

Capture's Main Window contains a toolbar providing quick access to important functionality. The
toolbar can be used to open RAD7 data files, switch between connected RAD7s, and perform
utility operations such as renaming a RAD7 and downloading data from all connected RAD7s.

These commands are described in detail below.

Open File Button

The Open File button brings up the Open Dialog, in which a RAD7 Data File may be opened in a
Graph Window.

Device Selection Buttons

Each connected RAD8, RAD7, and DRYSTIK is represented as a toolbar button, labeled with a
serial number or custom device name. The content of the Main Window pertains to whichever
device is currently selected in the toolbar.

Add Device Button

The Add Device button manually adds a new RAD8, RAD7, or DRYSTIK. It is necessary to add a
device manually when it is being reached via a local network. Additionally, a RAD7 must be added
manually if it does not have RADLINK installed and can not be discovered automatically. When a
device is added manually, the Connection Settings panel appears. This panel is described in detail
in the Connecting to the Instrument section.

Options Menu

Figure 1: The Options Menu in the Main Window toolbar.

The Options Menu is labeled with a gear icon and consists of several commands:

RAD8/RAD7/DRYSTIK Connection Settings

The RAD8/RAD7/DRYSTIK Connection Settings command brings up the Connection Settings
panel, which can be used to specify how the computer connects to the selected device. It is also
used when connecting to a RAD7 or DRYSTIK via a local network. The Connection Settings panel
is described in more detail in the Connecting to the Instrument section

Rename RAD8/RAD7/DRYSTIK...

The Rename RAD8/RAD7/DRYSTIK command brings up a dialog box in which a new name for the
selected device may be entered. The specified name appears under the device's icon in the
toolbar. If no name is specified, the RAD7 or DRYSTIK is referred to by its serial number.

Add RAD7 Group...

The Add RAD7 Group command creates a new RAD7 Group for the Chart Recorder and displays
the RAD7 Group Configuration dialog, which which is used to specify the group's name and its
member RAD7s. More information is available in the Monitoring Device Groups section.

Add RAD8 Group...

The Add RAD8 Group command creates a new RAD8 Group for the Chart Recorder and displays



the RAD8 Group Configuration dialog, which which is used to specify the group's name and its
member RAD8s. More information is available in the Monitoring Device Groups section.

Download Data From All RAD7s

The Download Data From All RAD7s command makes it possible to quickly obtain all of the raw
data from each connected RAD7. This process is described in the Downloading From All RAD7s
section.

(Re)scan for RAD7s

The Rescan for RAD7s command detects all of the RAD7s that are attached to the computer and
adds them to the Capture toolbar. Any RAD7s that were detected previously are removed, then
rediscovered. The Rescan for RAD7s button at the lower right corner of the Main Window
performs the same function as this menu command.

Disconnect Current RAD8/RAD7/DRYSTIK (or Remove Current RAD8/RAD7 Group)

The Disconnect Current RAD8/RAD7/DRYSTIK (or Remove Current RAD8/RAD7 Group) command
disconnects only the currently selected RAD7, DRYSTIK, or RAD7 Group. It may later be restored
by rescanning for devices or by manually adding a device or RAD7 Group.

Disconnect All Devices

The Disconnect All Devices command disconnects all RAD7s and DRYSTIKs and removes any
RAD7 Groups, leaving the Main Window empty. Devices may later be restored by rescanning or by
adding them manually.

Help Menu

Figure 2: The Help Menu in the Main Window toolbar.

The Help Menu provides quick access to the Capture User's Manual. The Capture Cloud Help
command within the Help Menu connects directly to the Capture Cloud section of the manual.



  APPENDIX C: FILE FORMATS

Capture utilizes several file formats during the retrieval, editing, and exporting of RAD8 and RAD7
test data. Several legacy formats are also supported, ensuring compatibility with a wide range of
existing data. Each supported radon file format and image file format is described below.

  RD8 Data File

Files with the .RD8 file name extension contain RAD8 test data. Capture can both open and save
RAD8 data using this file format. The data is stored in a JSON-based structure, which can be
opened using a text editor for viewing, although the raw file contents are not specifically designed
to be human-readable.

  R7CDT Data File

When data is downloaded from a RAD7 that has RADLINK installed, it is saved in the R7CDT
format. R7CDT files are text-based files, and they can be viewed, modified, and resaved in
Capture. Modifications may include the configuration of Run Parameters, or the assignment of a
custom RAD7 profile. R7CDT data may be opened and viewed in a text editor, but it may be
difficult to read since it contains complex information.

Earlier versions of Capture used the CDT file name extension instead of R7CDT. This has been
changed to avoid conflicts with unrelated files that use the same extension.

  R7RAW Data File

When radon concentration data is retrieved from a RAD7 that does not have RADLINK installed, it
is recorded to disk in the R7RAW format. A R7RAW file is a plain text file containing up to 1000
rows of radon test data. Each row is divided into 23 unlabeled columns, separated by commas.
Although this text is not easily human readable, it is well suited for graphing and analysis within
Capture and other applications. This 23 column format is fully documented in the PC Connectivity
section of the RAD7 manual.

Capture does not allow a R7RAW file to be modified and then saved back to disk under its original
name. Instead it must be saved in the R7CDT format.

Earlier versions of Capture used the RAW file name extension instead of R7RAW. This has been
changed to avoid conflicts with unrelated files that use the same extension.

Note that Capture can open files using unrecognized file name extensions. Users who have
renamed their R7RAW data files using custom extensions such as DAT and CAP will still be able to
view graphs of their RAD7 files, because Capture can determine a file's format based on its
content.

  TXT File

A TXT (Text) file is a plain text document that can be opened in any text editing or word processing
application. TXT files are created when exporting certain kinds of data from Capture, such as
RAD7 Printer Data and Data Summary Reports. Additionally, Capture can open legacy RAD7 Data
files that are stored in the TXT format.

  CSV Data File

The Export Column Based Data command can be used to create a CSV (Comma Separated
Values) data file. CSV files are text-based documents that use commas to separate data fields, and
they can be opened directly in Microsoft Excel and other spreadsheet applications.

  TSV Data File

The Export Column Based Data command also can be used to create a TSV (Tab Separated
Values) data file. TSV files are text-based documents that use tabs to separate data fields, and
they can be opened directly in Microsoft Excel and other spreadsheet applications.

  HTML File

When a Radon Inspection Report is exported from Capture, it is saved in the HTML format. It can
be opened in any web browser. Image content is embedded directly inside the HTML file.

  PNG Image File

When a graph image is saved using the Save Graph Picture command, Capture produces a PNG
image file. The PNG format uses lossless compression to ensure small image file sizes, without



sacrificing image quality.

  PDF Document

The PDF file format is a cross platform format for finished documents that generally can't be
modified. On most systems Capture's Print dialog box can be used to generate PDF files
containing graph images and basic graph statistics.
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